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Safety and Preparation For Use

WARNING!
Dangerous voltages, capable of causing injury or death, are
E present in this instrument. Use extreme caution whenever the
instrument cover is removed. Do not remove the cover while
the unit is plugged into a live outlet.

Caution
This instrument may be damaged if operated with the LINE VOLTAGE SELECTOR set
for the wrong AC line voltage or if the wrong fuse is installed.

Line Voltage Selection
The SR780 operates from a 100V, 120V, 220V, or 240V nominal AC power source
having a line frequency of 50 or 60 Hz. Before connecting the power cord to a power
source, verify that the LINE VOLTAGE SELECTOR card, located in the rear panel fuse
holder, is set so that the correct AC input voltage value is visible.

Conversion to other AC input voltages requires a change in the fuse holder voltage card
position and fuse value. Disconnect the power cord, open the fuse holder cover door and
rotate the fuse-pull lever to remove the fuse. Remove the small printed circuit board and
select the operating voltage by orienting the printed circuit board so that the desired
voltage is visible when pushed firmly into its slot. Rotate the fuse-pull lever back into its
normal position and insert the correct fuse into the fuse holder.

Line Fuse
Verify that the correct line fuse is installed before connecting the line cord. For
100V/120V, use a 1.5 Amp fuse. For 220V/240V, use a 3/4 Amp fuse.

Line Cord
The SR780 has a detachable, three-wire power cord for connection to the power source
and to a protective ground. The exposed metal parts of the instrument are connected to
the outlet ground to protect against electrical shock. Always use an outlet which has a
properly connected protective ground.

Service

Do not attempt to service or adjust this instrument unless another person, capable of
providing first aid or resuscitation, is present.

A
Do not install substitute parts or perform any unauthorized modifications to this
instrument. Contact the factory for instructions on how to return the instrument for
authorized service and adjustment.
Fan
The fans in the SR780 are required to maintain proper operation. Do not block the vents
in the chassis or the unit may not operate properly.
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Chapter 1

Performance Tests

The performance tests described in this section are designed to verify with a high degree of confidence

that the unit is performing within the specifications.

The results of each test should be recorded on the test sheet at the end of this section.
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Getting Ready

[Hardkeys]

The keypad consists of four groups of hardkeys (keys with printed labels).
Hardkeys are referenced in braces like [Active Display] or [Input].

The ENTRY keys are used to enter numeric parameters which have been highlighted by a
soft key. The MENU keys select a menu of soft keys. Pressing a menu key will change
the menu boxes which are displayed next to the soft keys. Each menu presents a group of
similar or related parameters and functions. The CONTROL keys start and stop data
acquisition, toggle the active display and link parameters and functions. These keys are
not in a menu since they are used frequently and within any menu. The FUNCTION keys
perform common functions such as Auto Scale and Auto Range. These keys can be
accessed at any time.

<Softkeys>

Knob

Reset

The SR780 has a menu driven user interface. The Menu keys each display a menu of
softkeys. The softkeys are at the right of the video display and have different functions
depending upon the displayed menu.

Softkeys are referenced in brackets like <Span> or <Units>.

There are three types of softkeys - buttons, lists and numeric values. A button performs a
function, such as <Full Span>. A list presents a list of choices or options in the entry field
(at the top of the screen). Use the knob to make a selection and press [Enter].
<Measurement> is an example of a list. A numeric value presents the current value in the
entry field and awaits numeric entry. Enter a new value with the entry keys and press
[Enter]. <Start Freq> is an example of a numeric value.

The knob normally moves the markers within the displays. If a parameter has been
highlighted by its softkey, the knob adjusts the parameter. List parameters are most easily
modified with the knob. Numeric parameters may also be adjusted with the knob.

Knob list selections are referenced in parenthesis like (Hanning).

Throughout this section, it will be necessary to reset the analyzer into a known default
state. To do this, press [System] to display the System menu and then press <Preset> and
[Enter] to confirm. The unit will perform power up tests and then assume the default
settings. Each test generally starts with a reset.

Serial Number

If you need to contact Stanford Research Systems, please have the serial number of your
unit available. The serial number is printed on a label affixed to the rear panel. The serial
number is also displayed on the screen when the unit is powered on.

Firmware Revision

The firmware revision code is displayed on the screen when the unit is powered on.
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Necessary Equipment
The following equipment is necessary to complete the performance tests. The suggested
equipment or its equivalent should be used.

Frequency Synthesizer

Freq Range 1 Hzto 1 MHz
Freq Accuracy better than 5 ppm
Amplitude Accuracy 0.2 dB from 1 Hz to 100 kHz
Harmonic Distortion <-65dBc
Spurious <-55dBc
Recommended SRS DS345
AC Calibrator
Freq Range 10 Hz to 100 kHz
Amplitude ImVtol0V
Accuracy 0.1%

External phase locking capability
Recommended Fluke 5200A

Feedthrough Terminations
Impedance 500

Warm Up
The analyzer should be turned on and allowed to warm up for at least an hour before any
tests are performed. The self test does not require any warm up period.

It is necessary to turn the unit off and on to reset it. As long as the unit is powered within
a minute, this will not affect the test results.

Auto Offset must be left enabled (On) in the [Input] <More> menu. Disabling Auto
Offset may invalidate the results of some tests.

The Test Record
Make a copy of the SR780 Performance Test Record at the end of this section. Fill in the
results of the tests on this record. This record will allow you to determine whether the
tests pass or fail and also preserve a record of the tests.

If A Test Fails
If a test fails, you should check the settings and connections of any external equipment
and, if possible, verify its operation using a DVM, scope or some other piece of test
equipment.

After checking the setup, repeat the test from the beginning to make sure that the test was
performed correctly.

If the test continues to fail, contact Stanford Research Systems for further instructions.
Make sure that you have the unit serial number and firmware revision code handy. Have
the test record on hand as well.
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1. Self Tests

The self tests check the analyzer hardware. These are functional tests and do not relate to the
specifications. These tests should be run before any of the performance tests.

Note that the Test menu offers more tests than are required here. Only those tests which require no
additional equipment are discussed in this section. The computer interface and disk drive tests are not
required but should be periodically checked. See the System menu for more information about those tests.

Setup

No external setup is required for this test.

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.
During re-boot, the DSP memory and calibration tests should all be OK.
To review this power on screen, use [System] <Show Version>.

2) Press the keys in the following sequence:

[System]
<Diagnostics>
<Keypad Test>
Press all of the front panel keys until all of the boxes are filled in.
Then press any key to exit this screen.

<Knob Test>
Rotate the knob to verify rotation and direction.
<Return>

<Memory >
<System RAM>
<Begin>
All of the system memory chips should Pass.
<Return>

<System ROM>
<Begin>
All of the system memory chips should Pass.
<Return>

<Video RAM>
<Begin>
All of the video memory chips should Pass.
<Return>
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<Help ROM>
<Begin>
All of the memory chips should Pass.
<Return>

<Return>

3) This completes the functional hardware tests. Enter the results of this test in the test record at the
end of this section.
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2. DC Offset

This test measures the DC offset of the input.

Setup

Connect a 50Q2 feedthrough termination to the Ch1l A and Ch2 A inputs. This shorts the inputs so the
analyzer's own DC offset will be measured.

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Press the keys in the following sequence:

[Freq]
<Span>
[1][.] [6] select (kHz) [Enter]

[Marker]
<Marker>
Select (Link) [Enter]
Use the knob to move the markers to 0 Hz.

[Average]
<Averaging Type>
Select (Linear) [Enter]
<# Avgs>
[1] [O] [Enter]
<Averaging>
Select (On) [Enter]

3) a) Press
[Input]
<Chl Input Range>
[-1[3] [0] [Enter]

<Ch2 Input Range>
[-][3]1 [0] [Enter]

[Start/Reset]

Wait for the average to finish.
[Auto Scale A]
[Auto Scale B]

b) Record the marker Y values for both displays on the -30 dBV range.
c) Press

<Chl Input Range>
[-] [5] [0] [Enter]
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<Ch2 Input Range>
[-1 [5]10] [Enter]

[Start/Reset]

Wait for the average to finish.
[Auto Scale A]
[Auto Scale B]

d) Record the marker Y values for both displays for the -50 dBV range.

4) This completes the DC measurement test. Enter the results of this test in the test record at the end
of this section.
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3. Common Mode Rejection

This test measures the common mode rejection of the analyzer inputs.

Setup

We will use the frequency synthesizer to provide the signal.

Connect the frequency synthesizer output to both the Chl A and Chl B inputs of the analyzer. Use equal
length cables from A and B to a BNC TEE. Connect the cable from the synthesizer output to the TEE.

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Set the frequency synthesizer to a frequency of 1 kHz and an amplitude of 500 mVrms.

3) Setup the measurement. Press the keys in the following sequence:

[Freq]
<Span>
[1][.] [6] Select (kHz) [Enter]
<Center Freq.>
[1] Select (kHz) [Enter]

[Input]
<Chl Input Range>
[-][2] [Enter]

[Average]
<Averaging Type>
Select (Linear) [Enter]
<# Avgs>
[1] [O] [Enter]
<Averaging>
Select (On) [Enter]
Wait for the average to finish.

[Auto Scale A]
[Marker Max]|
[Marker Ref]

[Input]
<Chl Input Mode>
Select (A-B) [Enter]

[Start/Reset]
Wait for the average to finish.

4) Record the marker Y reading. This is the Chl CMRR (in dB) at 1 kHz.
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5) Move the input cables from Chl A and B to Ch2 A and B.
Repeat the measurement for Ch2.
Press the keys in the following sequence:

[Active Display]
Make DisplayB the active display.

[Input]
<Ch2 Input Range>
[-][2] [Enter]

[Start/Reset]
Wait for the average to finish.

[Auto Scale B]
[Marker Max]
[Marker Ref]

[Input]
<Ch2 Input Mode>
Select (A-B) [Enter]

[Start/Reset]
Wait for the average to finish.

6) Record the marker Y reading. This is the Ch2 CMRR (in dB) at 1 kHz.

7) This completes the CMRR measurement test. Enter the results of this test in the test record at the
end of this section.
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4. Amplitude Accuracy and Flatness

This test measures the input amplitude accuracy and frequency response.

Setup
We will use the frequency synthesizer to provide an accurate frequency and the AC calibrator to provide a
sine wave with an exact amplitude.

Connect the output of the frequency synthesizer to the phase lock input of the calibrator. Connect the
output of the AC calibrator to the Ch1l A and Ch2 A inputs of the analyzer. Be sure to use the appropriate
terminations where required.

Set the Synthesizer to: Set the AC Calibrator to:
Function Sine Frequency 1.0 kHz
Frequency 1.0 kHz Amplitude 0.707 mVrms
Amplitude 0.5 Vrms Voltage Off
Offset off or OV Phase Lock On
Sweep off Sense Internal

Modulation none

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Press the keys in the following sequence:

[Window]
<Window>
Select (Flattop) [Enter]

[Freq]
<Span>
[1][.] [6] Select (kHz) [Enter]
<Center Freq.>
[1] Select (kHz) [Enter]

[Input]
<Chl Coupling>
Select (AC) [Enter]
<Ch2 Coupling>
Select (AC) [Enter]

[Average]
<Averaging Type>
Select (Linear) [Enter]
<# Avgs>
[1][0] [Enter]
<Averaging>
Select (On) [Enter]
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3) Amplitude accuracy is verified at 1.0 kHz and various input ranges. For each range setting in the
table below, perform steps 3a through 3d.

Input Range (pk) AC Calibrator Amplitude
-46 dBV 2.509 mVrms
-38 dBV 6.302 mVrms
-30 dBV 15.830 mVrms
-14 dBV 99.881 mVrms
4 dBV 0.7934 Vrms
10 dBV 1.5830 Vrms
22 dBV 6.3021 Vrms
34 dBV 25.089 Vrms

a) Set the AC calibrator to the amplitude shown in the table.

b) Press
[Input]
<Chl Input Range>
Enter the range from the table.
<Ch2 Input Range>
Enter the range from the table.

c) Press
[Start/Reset]
Wait for the average to finish.
[Auto Scale A]
[Auto Scale B]

[Link] [Marker Max]
d) Record the marker Y reading for both displays for each range.

4) Frequency response is checked at frequencies above 1 kHz. The test frequencies are listed below.
The measurements are performed for two different input ranges.

Test Frequencies
24 kHz
48 kHz
72 kHz
96 kHz

a) Set the AC calibrator to 1.0 kHz and an amplitude of 99.881 mVrms.
b) Set the frequency synthesizer to 1.0 kHz.

c) Press
[Frequency]
<Center Frequency.>
[1] Select (kHz) [Enter]
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[Input]
<Chl Input Range>
[-] [1][4] [Enter]
<Ch2 Input Range>
[-] [1][4] [Enter]

[Start/Reset]

Wait for the average to finish.
[Auto Scale A]
[Auto Scale B]

[Link] [Marker Max]
The Y value of the markers should both read -17.0 dB (+ 0.15 dB).

d) Set the AC calibrator and frequency synthesizer to the frequency in the table.
e) Press
[Frequency]
<Center Freq.>

Enter the signal frequency.

[Start/Reset]
Wait for the average to settle.

[Link] [Marker Max]

f) Record the marker Y reading for both displays. Repeat steps 4d and 4e for all of the
frequencies listed.

5) Now repeat the frequency response measurements at a different input range.
a) Set the AC calibrator to 1 kHz and an amplitude of 6.3021 Vrms.

b) Set the frequency synthesizer to 1 kHz.

c) Press
[Freq]
<Center Freq..>
[1] <kHz>
[Input]

<Chl Input Range>
[2] [2] [Enter]

<Ch2 Input Range>
[2] [2] [Enter]

[Start/Reset]
Wait for the average to finish.
[Auto Scale A]
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[Auto Scale B]

[Link] [Marker Max]
The Y value of the marker should now read +19.0 dB (+0.15 dB).

d) Repeat steps 4d through 4f above.

6) This completes the amplitude accuracy and frequency response test. Enter the results of this test
in the test record at the end of this section.
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5. Amplitude Linearity

This test measures the amplitude linearity. This tests how accurately the analyzer measures a signal
smaller than full scale.

Setup
We will use the frequency synthesizer to provide an accurate frequency and the AC calibrator to provide a
sine wave with an exact amplitude.

Connect the output of the frequency synthesizer to the phase lock input of the calibrator. Connect the
output of the AC calibrator to the Ch1l A and Ch2 A inputs of the analyzer. Be sure to use the appropriate
terminations where required.

Set the Synthesizer to: Set the AC Calibrator to:
Function Sine Frequency 1.0 kHz
Frequency 1.0 kHz Amplitude 6.3021 Vrms
Amplitude 0.5 Vrms Voltage Off
Offset off or OV Phase Lock On
Sweep off Sense Internal

Modulation none

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Press the keys in the following sequence:

[Window]
<Window>
Select (Flattop) [Enter]

[Freq]
<Span>
[1][.] [6] Select (kHz) [Enter]
<Center Freq.>
[1] Select (kHz) [Enter]

[Input]

<Chl Coupling>

Select (AC) [Enter]
<Ch2 Coupling>

Select (AC) [Enter]
<Chl Input Range>

[2] [2] [Enter]
<Ch2 Input Range>

[2] [2] [Enter]
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[Average]
<Averaging Type>
Select (Linear) [Enter]
<# Avgs>
[1] [0] [Enter]
<Averaging>
Select On [Enter]

[Start/Reset]

Wait for the average to finish.
[Auto Scale A]
[Auto Scale B]

[Link] [Marker Max]
3) For each of the amplitudes listed below, perform steps 3a through 3c.

AC Calibrator Amplitudes
6.3021 Vrms
1.1207 Vrms
141.09 mVrms
22.361 mVrms
3.544 mVrms

a) Set the AC calibrator to the amplitude in the table.
b) Press [Start/Reset] and wait for the average to finish.
¢) Record the marker Y reading for both displays.

4) This completes the amplitude linearity test. Enter the results of this test in the test record at the
end of this section.
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Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

We will use the frequency synthesizer to provide the signal.

3) Press the keys in the following sequence:

[Freq]
<Span>

[8][0] [0] Select (Hz) [Enter]

<Center Freq.>

[1][0] [2] Select (kHz) [Enter]

[Input]
<More>
<Chl AA Filter>
Select (Off) [Enter]
<Ch2 AA Filter>
Select (Off) [Enter]

[Average]
<Averaging Type>
Select (Linear) [Enter]
<# Avgs>
[1][0] [Enter]
<Averaging>
Select On [Enter]

[Start/Reset]

Wait for the average to finish.

[Auto Scale A]
[Auto Scale B]

[Link] [Marker Max]
[Link] [Marker Ref]

6. Anti-alias Filter Attenuation

This test measures the attenuation of the anti-alias filters. This tests how well the analyzer rejects
frequencies outside the 102.4 kHz frequency range.

Connect the output of the frequency synthesizer to the Chl A and Ch2 A inputs of the analyzer. Be sure
to use the appropriate terminations where required.

2) Set the frequency synthesizer to a frequency of 160.144 kHz and an amplitude of 500 mVrms.

This references the un-filtered out of band signal at 160.144 kHz aliased to

102.0 kHz.
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4) Measure the anti-alias filter attenuation. Press
[Input]
<More>
<Chl AA Filter>
Select (On) [Enter]
<Ch2 AA Filter>
Select (On) [Enter]

[Start/Reset]
Wait for the average to finish.

Record the marker Y readings for both displays.

5) This completes the anti-alias filter attenuation test. Enter the results of this test in the test record
at the end of this section.
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7. Frequency Accuracy

This test measures the frequency accuracy of the analyzer. This tests the accuracy of the fundamental
crystal timebase inside the unit.

Setup
We will use the frequency synthesizer to provide the signal.
Connect the output of the frequency synthesizer to the Chl A input of the analyzer. Be sure to use the
appropriate terminations where required.
Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Set the frequency synthesizer to a frequency of 96.000 kHz and an amplitude of 500 mVrms.

3) Press the keys in the following sequence:

[Freq]
<Span>
[2] [0] [0] Select (Hz) [Enter]
<Center Freq.>
[9] [6] Select (kHz) [Enter]

[Auto Scale A]
[Marker Max]|

4) Wait for the spectrum to settle (at least 5 seconds), then record the marker frequency reading for
DisplayA.

5) This completes the frequency accuracy test. Enter the results of this test in the test record at the
end of this section.
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8. Phase Accuracy

Setup

We will use the frequency synthesizer to provide the signal.

Procedure

This test measures the phase accuracy of the analyzer. This test measures the phase of a signal relative to
the trigger.

Connect the output of the frequency synthesizer to the Trigger, Chl A and Ch2 A inputs of the analyzer.
Be sure to use the appropriate terminations where required.

1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Set the frequency synthesizer to a frequency of 10.240 kHz and an amplitude of 500 mVrms.

3) Press the keys in the following sequence:

[Input]
<Chl Input Range>
[-][2] <dBV>
<Ch2 Input Range>
[-][2] <dBV>
<Chl Coupling>
Select (AC) [Enter]
<Ch2 Coupling>
Select (AC) [Enter]

[Trigger]
<Trigger Source>
Select (Chl) [Enter]
<Trigger Mode>
Select (Auto Arm) [Enter]

[Auto Scale A]
[Auto Scale B]

[Marker]
<Marker>
Select (Link) [Enter]

[Marker Max]|
[Display Setup]

<View>
Select (Phase) [Enter]
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[Active Display]
Make DisplayB the active display.

[Display Setup]
<View>
Select (Phase) [Enter]

[Auto Scale A]
[Auto Scale B]

[Average]

<# Avgs>

[1] [0] [Enter]
<Average Mode>

Select (Vector) [Enter]
<Averaging Type>

Select (Linear) [Enter]
<Averaging>

Select On [Enter]

4) Record the marker Y readings for both displays. (Make sure that the marker frequency is
10.24 kHz)

5) This completes the phase accuracy test. Enter the results of this test in the test record at the end of
this section.
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9. Noise and Spurious Signals

This test measures the analyzer noise floor and checks for spurious signals.

Setup

Connect 50Q2 feedthrough terminations to the Chl A and Ch2 A inputs. This grounds the inputs so the
analyzer's input noise is measured.

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Press the keys in the following sequence:

[Freq]
<Span>
[ST[1][.112] Select (kHz) [Enter]
<Start Freq.>
[51[1][2] Select (Hz) [Enter]

[Window]
<Window>
Select (Hanning) [Enter]

[Input]

<Chl Input Range>

[-1 [5] [0] [Enter]
<Ch2 Input Range>

[-1 [5][0] [Enter]
<Chl Coupling>

Select (AC) [Enter]
<Ch2 Coupling>

Select (AC) [Enter]
<Chl Grounding>

Select (Ground) [Enter]
<Ch2 Grounding>

Select (Ground) [Enter]

[Display Options]
<PSD Units>
[Link] Select (On) [Enter]

[Display Setup]
<Units>
[Link] Select (dBVrms/\Hz) [Enter]
<Y max>
[Link] [-] [1] [0] [0] [Enter]
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[Average]
<# Avgs>
[2] [0] [Enter]
<Averaging Type>
Select (Linear) [Enter]
<Averaging>
Select On [Enter]

[Marker]
<Width>
[Link] Select (Wide) [Enter]
<Seeks>
[Link] Select (Mean) [Enter]

[Start/Reset]
Wait for the average to finish.

[Link] [Marker Max]
3) Record the marker Y readings for both displays.

4) Press

[Freq]
<Start Freq.>

[5T1111.]112] Select (kHz) [Enter]

[Start/Reset]
Wait for the average to finish.

[Link] [Marker Max]
5) Record the marker Y readings for both displays.

6) Press
[Display Options]
<PSD Units>
Select (Off) [Enter]

[Display Setup]
<Units>
Select (dBVpk) [Enter]

[Marker]
<Seeks>

Select (Max) [Enter]

7) For each of the spans listed below, perform steps 7a through 7c.

SR780 Network Signal Analyzer



Performance Tests 1-27

Center Frequency

230 Hz

500 Hz

1 kHz

5 kHz

10 kHz

25 kHz

50 kHz

75 kHz

101 kHz

a) Press

[Freq]
<Span>

Enter the span from the table

<Center Freq.>

Enter the center frequency from the table

b) Wait for the average to finish (20 averages).

[Link] [Marker Max]

¢) Record the marker Y readings for both displays.

Span
400 Hz

400 Hz
1.6 kHz
1.6 kHz
1.6 kHz
1.6 kHz
1.6 kHz
1.6 kHz
1.6 kHz

8) This completes the noise and spurious signal test. Enter the results of this test in the test record at

the end of this section.
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10. Sine Source

This test measures the source sine output.

Setup
Connect the Source output to the Chl A input.

Procedure

1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.

2) Press the keys in the following sequence:

[Source]
<Amplitude 1>
[1][0] [0] [0] [Enter]

[Auto Range Chl1] and wait until the range stops changing.

[Auto Scale A]
[Marker Max]|
3) Record the marker Y reading for DisplayA.

4) Press
<Amplitude 1>
[1][0] [0] [Enter]

5) Record the marker Y reading for DisplayA.

6) Press
<Amplitude 1>
[1] [O] [Enter]

7) Record the marker Y reading for DisplayA.
8) Press

<Amplitude 1>
[11 0] [0] [0] [Enter]

9) For each of the frequencies below, perform steps 9a and 9b.

Frequency
20.48 kHz

40.96 kHz
61.44 kHz
81.92 kHz
99.072 kHz
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a) Press
<Frequency 1>
Enter the frequency from the table.
[Marker Max]
b) Record the marker Y reading for DisplayA.

8) This completes the source sine test. Enter the results of this test in the test record.
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11. Harmonic Distortion

This test measures the harmonic distortion of the analyzer source and inputs.

Setup
Connect the source output to the Chl A and Ch2 A inputs of the analyzer.

Procedure
1) Reset the unit by pressing [System] <Preset> and then [Enter] to confirm.
This sets the source to sine output at 10.24 kHz and 500 mVpk amplitude.

2) Press the keys in the following sequence:

[Input]
<Chl Input Range>
[-][4] [Enter]
<Ch2 Input Range>
[-][4] [Enter]

[Auto Scale A]
[Auto Scale B]

[Average]
<# Avgs>
[2] [5] [Enter]
<Averaging Mode>
Select (Vector) [Enter]
<Averaging>
Select (On) [Enter]

[Marker]
<Mode>
[Link] Select (Harmonic) [Enter]
<# Harmonics>
[Link] [5] [Enter]

[Link] [Marker Max]
3) Record the THD reading for DisplayA (from the THD menu box).
4) Press
[Active Display]
Make DisplayB the active display.
5) Record the THD reading for DisplayB (from the THD menu box).

6) This completes the harmonic distortion test. Enter the results of this test in the test record at the
end of this section.
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SR780 Performance Test Record Page I of 3
Serial Number Tested By
Firmware Revision Date
Equipment Used
1. Self Tests
Test Pass Fail
Power On Test _ L
Keypad _ L
Knob L L
System RAM _ L
System ROM _ L
Video RAM _ L
Help ROM _ _
2. DC Offset
Input Range  DispA (Chl) DispB (Ch2) Upper Limit
-30 dBV <-80dBV
-50 dBV <-80dBV
3. Common Mode Rejection
Input Range Frequency DispA (Chl) DispB (Ch2) Upper Limit
-2 dBV 1.0 kHz <-90 dB
4. Amplitude Accuracy and Flatness
Input Range  Calibrator Ampl. Lower Limit  DispA (Chl) DispB (Ch2) Upper Limit
-46 dBV 2.509 mVrms -49.20 dBV -48.80 dBV
-38 dBV 6.302 mVrms -41.20 dBV -40.80 dBV
-30 dBV 15.830 mVrms -33.20 dBV -32.80 dBV
-14 dBV 99.881 mVrms -17.20 dBV -16.80 dBV
4 dBV 0.7934 Vrms 0.80 dBV 1.20 dBV
10 dBV 1.5830 Vrms 6.80 dBV 7.20 dBV
22 dBV 6.3021 Vrms 18.80 dBV 19.20 dBV
34 dBV 25.089 Vrms 30.80 dBV 31.20 dBV
Flatness relative to 1 kHz
Input Range Frequency Lower Limit  DispA (Chl) DispB (Ch2) Upper Limit
-14 dBV 24 kHz -17.20 dBV -16.80 dBV
-14 dBV 48 kHz -17.20 dBV -16.80 dBV
-14 dBV 76 kHz -17.20 dBV -16.80 dBV
-14 dBV 99 kHz -17.20 dBV -16.80 dBV
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SR780 Performance Test Record Page 2 of 3
4. Amplitude Accuracy and Flatness (Continued)
Flatness relative to 1 kHz
Input Range Frequency Lower Limit  DispA (Chl) DispB (Ch2) Upper Limit
22 dBV 24 kHz 18.80 dBV 19.20 dBV
22 dBV 48 kHz 18.80 dBV 19.20 dBV
22 dBV 72 kHz 18.80 dBV 19.20 dBV
22 dBV 96 kHz 18.80 dBV 19.20 dBV
5. Amplitude Linearity
Input Range  Calibrator Ampl. Lower Limit  DispA (Chl) DispB (Ch2)  Upper Limit
22 dBV 6.3021 Vrms 18.80 dBV 19.20 dBV
1.1207 Vrms 3.80 dBV 4.20 dBV
141.09 mVrms -14.20 dBV -13.80 dBV
22.361 mVrms -30.20 dBV -29.80 dBV
3.544 mVrms -46.20 dBV -45.80 dBV
. Anti-Alias Filter Attenuation
Input Frequency  DispA (Chl) DispB (Ch2)  Upper Limit
160.144 kHz <-90 dB
. Frequency Accuracy
Input Frequency Lower Limit DispA Upper Limit
96.000 kHz  95.9976 kHz 96.0024 kHz
. Phase Accuracy
Frequency Trigger Source Lower Limit  DispA (Chl) DispB (Ch2)  Upper Limit
10.24 kHz Chl -93.0 deg -87.0 deg
. Noise and Spurious Signals
Noise floor Start Frequency Span DispA (Chl) DispB (Ch2) Upper Limit
512 Hz 51.2 kHz -160 dBVrms/VHz
51.2 kHz 51.2 kHz -160 dBVrms/\Hz
Spurious signals  Center Frequency Span DispA (Chl) DispB (Ch2)  Upper Limit
230 Hz 400 Hz -135 dBVpk
500 Hz 400 Hz -140 dBVpk
1 kHz 1.6 kHz -140 dBVpk
5kHz 1.6 kHz -140 dBVpk
10 kHz 1.6 kHz -140 dBVpk
25 kHz 1.6 kHz -140 dBVpk
50 kHz 1.6 kHz -140 dBVpk
75 kHz 1.6 kHz -140 dBVpk
101 kHz 1.6 kHz -140 dBVpk
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SR780 Performance Test Record

Page 3 of 3

10. Sine Source

Amplitude
Frequency Level Lower Limit DispA Upper Limit
1 kHz 1000 mV -0.3 dBV 0.3 dBV
1 kHz 100 mV -20.3 dBV -19.7 dBV
1 kHz 10 mV -40.3 dBV -39.7 dBV
Amplitude Flatness
Frequency Level Lower Limit DispA Upper Limit
20.48 kHz 1000 mV -0.3 dBV 0.3 dBV
40.96 kHz 1000 mV -0.3 dBV 0.3 dBV
61.44 kHz 1000 mV -0.3 dBV 0.3 dBV
81.92 kHz 1000 mV -0.3 dBV 0.3 dBV
99.072 kHz 1000 mV -0.3 dBV 0.3 dBV
11. Harmonic Distortion
Fundamental  DispA THD DispB THD  Upper Limit
10.24 kHz <-80 dB
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Chapter 2

Circuit Description

This chapter provides descriptions of the circuitry in the SR780. Each circuit board’s function and

operation is discussed. The schematics for each board are shown in Chapter 10.
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Overview

The SR780’s circuitry is divided into two major sections - the system section and the
analyzer section. The system section contains the main processor (CPU), video display,
external interfaces, power supply and front panel. The analyzer section contains the
digital signal processor (DSP), source output and analog inputs.

System Components
The system section components are located in the left half of the chassis, behind and
below the CRT (video display). The card cage behind the CRT contains the power
supply, main CPU card and the video/IO card. The cards are interconnected by a
backplane board under the card cage. The disk drive is mounted to a small board beneath
the CRT. This card can be removed from the front. The keypad connects to the disk board
at the front of the chassis.

Figure 2-1 System Components

Chassis Top View

CPU

Video/IO

Power
Supply

Backplane

CRT
Enclosure

Disk Card | I Keypad
| Board

Disk Drive

Front

Analyzer Components
The analyzer section is in the right half of the chassis, directly behind the keypad. A card
cage contains the DSP board and two identical analog input boards. The analyzer boards
are interconnected by a backplane board under the card cage. This backplane extends all
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the way to the front panel BNC connectors. The analyzer backplane connects to the
system backplane via two short cables at the center of the chassis just behind the CRT.

Figure 2-2 Analyzer Components

Chassis Top View

—

DSP Board

Chl Analog
Input Board

Ch2 Analog
Input Board

Analyzer
Backplane

Front

Both the system and the analyzer backplanes are passive and contain no active circuitry.
They only provide power distribution, signal routing between the various boards and to
external ports or devices.

Schematic Diagram Locations
Schematic diagrams are located in Chapter 5.

Board/Assembly Schematic #’s (see Chapter 10)
CPU Board MCPU-1 through MCPU-9
Video/IO Board MVID-10 through MVID-14
Power Supply MPWR-1 through MPWR-2
System Backplane MBKPL-20 through MBKPL-23
Disk Card MBKPL-24

Keypad Board MKEY-1

DSP Board D780-1 through D780-9

Analog Input Boards ~ A780-1 through A780-7
Analyzer Backplane =~ M780-1 through M780-4
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CPU Board

This section covers schematics MCPU-1 through MCPU-9 in Chapter 5.

The CPU board contains the main microprocessor system. CPU memory, front panel and
printer interfaces are on this board. Two off-board data buses are also driven from this
board. The I/O Expansion data bus connects the CPU board with the Video/IO and Aux
slots on the System backplane. The External data bus connects to the DSP Board via the
Analyzer backplane.

Microprocessor System

The microprocessor, U101, is an 80C186XL (or 80C186EA) microcontroller which
integrates a fast 16 bit processor, counter-timers, interrupt controller, DMA controller,
and I/O decoding into a single component.

The 80C186 is clocked at 40.00 MHz by crystal oscillator U103. The external clock
period is 2 oscillator cycles or 20.0 MHz. The data and lower 16 bits of address are
multiplexed on processor lines AD0O-AD15. U201, U202, U203 latch the address A0-A19
at the beginning of each memory or I/O cycle. U204 and U205 are bi-directional data bus
drivers which are active during the data read/write portion of each memory or I/O cycle.
U201-U205 provide the on-board System bus.

Memory Map

The 80C186 can address 1 Mbyte of memory and 64k of I/O space. The memory is
mapped into 5 blocks. Each block has 2 sockets, one for the low byte and one for the high
byte of data.

U301-U304 are 128 kbyte EPROMS mapped from 80000H to FFFFFH. EPROMS U305
and U306 are mapped from 50000H to 7FFFFH for a total of 704 kbytes of program
ROM.

U401-U404 are 128 kbyte CMOS static RAMs mapped from 00000H to 4FFFFH
(320 kbytes). U401 and U402 (256 kbytes) are battery backed up.

/0 Map

U209 and U210 are the data bus drivers for the off-board I/O Expansion bus. U206 and
U207 are the data bus drivers for the off-board External (DSP) bus. U208 is the address
driver for the External bus.

U213 is a PAL which enables the correct bus drivers depending upon the I/O address
space being accessed. All memory accesses and on-board I/O use the System bus.

The 80C186 generates 7 peripheral chip select strobes, each covering 128 byte [/O
addresses. -PCSO0 enables on-board 1/O peripherals (front panel, clock and printer port).
-PCS1 enables the peripherals on the Video/IO board. -PCS2 enables the AUX
connectors on the System backplane. -PCS1 and -PCS2 enable the Expansion data bus. -
PCS4 and -PCS5 enable the External (DSP) bus. -PCS4 enables processor addressable
peripherals on the DSP board.
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U501 and U503 decode the on-board 1/O locations enabled by -PCS0. These are the
knob, keypad and keyboard, the clock, the printer port and the system status port.

U508 is a wait state generator. Extra wait states are generated by all I/O accesses. These
extra wait states are canceled if the access is to the External bus. The -Video Rdy signal
also ends the wait generation. -Video_Rdy signals that the graphics processor (on the
Video/IO board) has acknowledged an IO cycle and is ready.

Interrupts generated by system peripherals (on both the CPU and Video/IO boards) are
combined in U505 into a single prioritized interrupt. The highest priority pending
interrupt will be encoded on U505's outputs and read via the status port, U608. The
UART directly interrupts the processor since it can never be masked.

String ROM
U801 and U802 are 256 kbyte EPROMS containing the on-screen help information.
These memories are mapped into the upper 32k of I/O space. One of the sixteen 32k
banks is selected by BA15..BA18 set in the system status port. This keeps ROM data
from using up program memory space.

Keypad Interface
The keypad is organized as 8 columns and 8 rows of switch closures. The conductive
rubber keys provide the switch closures. U607 strobes the columns and U606 detects the
switch closure. The diodes D601-D608 prevent one column from affecting another. All of
the outputs from U607 are set high and U606 is read periodically by the processor. As
long as O0H is read, no key is pressed and the strobes are left on. When a non-zero value
is read, then the key strobes are activated individually in order to decode which key is
down.

Spin Knob
The knob is an optical encoder buffered by U612. Each transition of its quadrature
outputs is clocked into U610 or U611 and generates an interrupt at the output of US07B.
The processor keeps track of the knob's direction and speed.

Keyboard Interface
The PC keyboard interface uses U603 to convert serial data from the keyboard into a
parallel byte for the processor to read. The data format from the keyboard is a leading
start bit followed by 8 data bits. U603 is reset by a processor read. When a key is pressed,
the bits are shifted into U603. When the start bit appears at the QH output, 7 bits of the
data byte are in U603. U601 is the 9th bit of the shift register. When U601 clocks in the
start bit, U601 must have the 8 bits of the data. U601 then latches the serial data in U601
and interrupts the processor.

Only keyboards which operate in the PC or 8088 mode will function with this interface.

Speaker
The speaker is driven by a timer on the 80C186. The timer outputs a square wave which
is enabled by U507A and drives the speaker through Q705.
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Clock/Calendar
U702 is an MC146818 real time clock chip which keeps track of time and date. The time
base is a 32.768 kHz oscillator made by U706. Both U702 and U706 are battery backed

up.

Reset/Battery Switch
U701 is the processor supervisor. Power on reset is detected by U701 and signaled to the
processor via -Pwr_Reset. In addition, the chip enables to the battery backed-up memory
U401 and U402 are protected by U701. Q701 provides normal 5V power to the battery
circuits when the power is on.

Printer Interface
The printer interface is a normal Centronics style parallel port. Output data is buffered by
U703, an LS octal latch. Output control bits are buffered by the open collector driver
U704, and input control bits are discriminated by U705A and U705B.

Expansion Connector
The 120 pin connector carries all of the necessary interconnections to the System
backplane. Both the Expansion and External buses are carried off-board via this
connector. Power is also delivered through this connector.
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Video/lO Board

This section covers schematics MVID-10 through MVID-14 in Chapter 5.

The Video/IO board contains the display generation hardware, the GPIB and RS232
interfaces and the disk controller.

Video Graphics Interface

The video graphics interface is centered around U1003, an HD63484 graphics controller.
The HD63484 generates the video sync signals, controls the video memory, draws
graphic primitives such as lines, circles, polygons, etc. and performs many memory to
memory functions. The HD63484 relieves the 80C186 from having to calculate each
video image and greatly increases display speed.

Commands and data are sent from the 80C186 to the HD63484 using a DMA channel.
This allows the HD63484 to process commands without having to wait for the 80C186 to
send them.

U1006 and U1007 are 128 kbyte RAMs which make up the 256k video memory. Each
pixel is made up of 2 bits. The video screen is S00H by 600V and requires 120,000 bytes
of memory. The remaining memory is used to store patterns and fonts as well as a second
display screen. The data and address are multiplexed and U1004 and U1005 are the
address latches.

Memory is accessed twice during each display cycle. The first access reads the 16 bits of
video data for the current display cycle. The second access is used by the controller for
drawing purposes. During the drawing access, data at any address may be read or written.
This allows drawing to take place as fast as possible.

Data is read 16 bits at a time. When data is required for the display, the even data bits are
latched into U1008 and the odd data bits are latched into U1009. U1008 and U1009 are
parallel to serial converters. The video data is shifted out at 19.59 MHz and synchronized
by U1013. U1014A synchronizes the Display Enable to disable the video data except
during active display times.

The display consists of two layers or planes. Data on the front plane appears in front of
data on the rear plane. Each pixel requires two bits of information. The even bit is drawn
on the front plane and the odd bit is drawn on the rear plane. The even bit disables the
odd bit which puts it in front. U1012 handles the layering logic. The display planes make
it simple to draw a graph in front of a grid.

The two display planes each have their own display brightness. This gives the display a
three dimensional appearance. Current sources Q1101 and Q1102 set the brightness for
the front and rear planes. U1101 is a dual DAC which programs the two current sources.

Disk Controller

U1201 is a DP8473 disk controller which integrates all of the functions of the PC disk
interface into a single IC. All motor controls, read and write signals, and data are
controlled by the DP8473. A DMA channel is used to send and receive data from the
controller in order to satisfy the disk drive timing.
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GPIB Interface
The GPIB (IEEE-488) interface is provided by U1202, a TMS9914A controller. U1203
and U1204 buffer data I/O to the GPIB connector. U1202 is programmed to provide an
interrupt to the processor whenever there is bus activity addressed to the unit.

RS232 Interface
The SCN2641 UART, U1303, provides all of the UART functions including baud rate
generation. Standard baud rates up to 19.2k can be generated from the 3.6864 MHz
clock. U1305 buffers the outgoing data and control signals. Incoming signals are received
by U1304.

The RS232 port is a DCE and may be connected to a PC using a standard serial cable (not
a "null modem" cable).

Expansion Connector
The 120 pin connector carries all of the necessary interconnections to the System
backplane. Power is also delivered through this connector. Peripherals on this board are
accessed whenever -PCS1 from the CPU is active. U1401 and U1402 provide on-board
decoding.
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Power Supply Board

This section covers schematics MPWR-1 through MPWR-2 in Chapter 5.

Caution

Al

Dangerous voltages are present on this circuit board whenever the instrument is
attached to an AC power source and the rear panel power switch is "ON".

Always disconnect the power cord and wait at least one minute before opening
the unit. Check the LED at the top edge of the power supply board. The unit is
safe only if the LED is OFF. If the LED is ON, then DO NOT attempt any service
on the unit.

Removing the Power Supply

Never remove or replace this board when the power cord is attached!

The Power Supply Board is held in by two rear panel screws which hold the power
supply shield to the chassis. These screws prevent accidental removal of this board. The
unit should never be operated without these screws in place.

Power Supply Connector

The 120 pin connector carries all of the necessary interconnections to the System
backplane. Switch AC and the transformer secondaries are carried by this connector. The
supply outputs to the System and Analyzer backplanes is also carried by this connector.
For safety, this board cannot be inserted backwards.

Test Points

The test points along the top edge of the board are provided for supply testing while the
instrument is powered ON. These test points are current limited for safety. Always
measure the supply voltages relative to the correct ground test point as labeled on the
board.

System Power

The system power for the System backplane, CPU, Video/l1O, disk drive and CRT is
provided by the switching power supply module mounted on the Power Supply board.
This switcher is inside the power supply shield. The switcher accepts AC line input and
generates +5V, -5V, +12V and -12V. The +5V powers all of the system logic (CPU and
Video/10) as well as the DSP logic. +12V powers the CRT and the fans.

Analog Power

Analog power to the Analyzer backplane is generated by a linear power supply. The
transformer on the rear panel provides two 41 VAC center tapped secondaries and two
26VAC secondaries. The 41 VAC secondaries are used to generate +20VDC supplies for
the analog inputs and the source output. The 26 VAC secondaries generate +30V isolated
supplies for the ICP power.
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Bridge rectifiers D1-D4 and D5-D8 rectify the 41VAC secondaries. Filter capacitors
C10-C11 and C20-C21 provide filtered 28 VDC. Resistors provide a bleed current on all
of the unregulated supply filter capacitors. Because of the large capacitance in this
circuit, the time for the voltages to bleed to zero is about a minute after the power is
turned off.

The £20VDC supplies are generated by voltage regulators U10-U11 and U20-U21. These
supplies are floating on this board. The ground reference for £20V_D (source power) is
on the DSP board. This supply floats if no DSP board is plugged in. The ground
reference for £20V_A (analog power) is on the analog input boards. This supply floats if
no analog input board is plugged in.

The +30V supplies are very low current and only require small 100 mA regulators U30
and U40.
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DSP Board

This section covers schematics D780-1 through D780-6 in Chapter 5.

The DSP board takes digital inputs from the A/D Converters on the Analog Input boards
and performs all of the computations related to the measurement before it is displayed on
the screen. This includes digital heterodyning (frequency shifting), digital filtering and
downsampling, Fast Fourier Transforming, averaging, and output display processing
(scaling, magnitude calc, log, sqrt, etc.) These functions are implemented within a system
comprised of four functional blocks: the Digital Signal Processor (DSP), the Timing
Generator, the I/0 Interface and the Trigger Input.

The fifth functional block is the Source Generator. The source is synthesized, filtered and
attenuated before being passed to the output connector.

Digital Signal Processor
The SR780 utilizes a single ADSP21020 digital signal processor clocked at 33 MHz. All
instructions are completed in a single 30 ns cycle. The ADSP21020 has two external data
buses - Data Memory (DM) and Program Memory (PM). There is no internal memory.
Program memory is 128k x 48 and Data memory is 128k x 40. The memory is mounted
on two SIMM modules. Each SIMM module contains 128k words of 20 ns 128k x 8
memory IC’s.

In addition, a 2M x 32 DRAM module is located on the DM bus. This module may be
upgraded to 4M or 8M x 32. PAL U301 provides simple DRAM refresh and control
functions. Accesses to the DRAM are always multi-cycle. The DRAM is used for
capture, waterfall and trace storage. These functions do not require fast multiple memory
accesses.

Communication between the DSP and the host CPU (80C186) is handled through FIFO
memories U302-U304. These are 25 ns, 4k x 9 FIFO’s. U302 and U303 provide a 16 bit
wide data path from the DSP to the host CPU. This allows data to flow to the host for
display as fast as possible. U304 provides an 8 bit data path from the host CPU to the
DSP for commands and data. The FIFO’s allow the sender and the receiver to run at their
full rates without waiting for the other.

The DSP can interrupt the host by raising the “186INTO line (output from port U710) and
latching the request in U720A. The host clears the interrupt by writing to address
-INTO_CLR (decoder U80S5). The host CPU can interrupt the DSP via -IRQO0 and -IRQ1
by writing to ports in U80S5. These interrupts are generally used by the sender to signal
that a FIFO is full and the receiver should read the FIFO.

Timing Signal Generator
The timing signal generator provides all timing signals for the A/D and D/A Converters
and their corresponding serial ports. The master clock is chosen from either U705
(30.208 Mhz) or U706 (30.933 Mhz). U706 is used if the FFT Base Frequency is 102.4
kHz and U705 is used if the FFT Base Frequency is 100.0 kHz. U701-U703 implement a
118 state 7-bit counter. The state machine generates the convert clocks, frame sync and
bit clocks for the converters. U716 re-synchronizes the clock signals and drives the off-
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board signals to the Analyzer backplane. U712 latches the state of the timing generator
when a trigger signal is detected.

The timing generator interrupts the DSP whenever the serial ports (A/D and D/A) are
ready (every sample time). The trigger is also synchronized to the state machine and
generates an interrupt.

1/O Interface
The A/D converters on the analog boards send a serial data stream to the DSP board.
Each analog board uses a dual 16 bit converter with both channels digitizing the signal.
Each board returns two data streams for a total of four A/D channels. U401-U404 and
U405-U408 are 32 bit serial to parallel converters, each receiving two 16 bit data
channels from a single analog board.

U409-U410 is a 16 bit parallel to serial converter which sends DSP data to the source
D/A converter.

Trigger
The Trigger input can be a TTL level signal or an analog signal. T601 provides some
common-mode rejection for the trigger input. Relay K602 selects TTL or Analog Level
Trigger. Relay K601 allows the trigger signal to come from the output of the analog
front-end amplifiers or the external "TRIGGER" front panel BNC. Trigger signals pass
through the XOR gate U602C where rising or falling edge trigger slope is selected. TTL
triggers proceed directly to the XOR gate via some input protection. Analog level signals
are first converted to a TTL signal via high-speed comparator U603.

At the heart of the trigger input is the analog high-speed comparator, U603 (LT1016).
The input is buffered by U601A and limited by diodes D601 and D6302. N601 divides
the trigger signal and trigger level by two to accommodate the input range of the
comparator. C604 provides high-frequency hysteresis when the output latch cannot
respond fast enough, and U601B and U602A provide low-frequency hysteresis. R603
and N601A determine the level of hysteresis. The DC trigger level is set by the 8-bit
DAC U607A. U606 buffers and shifts the DAC output.

The Trig_In signal is latched in PAL U703 which synchronizes the trigger to the A/D
clocks and interrupts the DSP.

Source Generator
The source is output by DAC U501 (AD766). Since the DAC is clocked synchronously
with the A/D converters, the source is synchronous with the input sampling.

The output of U501 is buffered by U502 (AD744). U505-U507 form an elliptic anti-
aliasing filter to remove high frequency components. K501 selects the anti-aliasing filter
output or the pink noise filter output (U530) as the source. USO9A is used as an 8 bit
attenuator and U510 is a divide by 10 or 100 attenuator. U512 is a high current output
buffer which provides the low output impedance.

Interface To CPU
The CPU interface provides the communication pathway between the DSP board and the
main CPU board. All signal interconnections are made via the 120 pin connector J902.
U801-U803 are buffers for the address and data bus connections. These buffer chips are
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enabled only when the CPU board is writing to the DSP board. This is signaled by -PCS4
from the 80C186. This helps isolate the activity on the CPU board from affecting
circuitry on the DSP board. U808 and U809 are simple latches used to hold configuration
data for the DSP board. U805 is a decoder which generates the chip selects and strobes
needed by the DSP board. U810 is a serial EEPROM which holds the calibration data
required by the source and trigger circuits.

SR780 Network Signal Analyzer Service Guide



Circuit Description 2-15

Analog Input Boards

This section covers schematics A780-1 through A780-7 in Chapter 5.

The Analog Input boards provide the very important link between the user's input signal

and the DSP processor. From the front panel BNC, the user's signal passes through a low
distortion front-end amplifier, gain stages, attenuators, anti-aliasing filter, and finally an

A/D Converter. Once converted to digital form, the input signal is ready to be processed

by the DSP.

The two inputs use identical Analog Input boards. The routing on the Analyzer backplane
keeps them separate.

Input Amplifier
The goal of any measurement instrument is to perform some given measurement while
affecting the quantities to be measured as little as possible. As such, the input amplifier is
often the most critical stage in the entire signal path. The design of the front end input
amplifier in the SR780 was driven by an effort to provide optimum performance in the
following areas: input voltage noise, input current noise, input capacitance, harmonic
distortion, and common mode rejection (CMR). To provide such performance, an FET
differential input amplifier with common-mode feedback architecture was chosen.

The input signal is first passed through a series of relays to select input mode (K102),
input coupling (K104) and input attenuation (K105, K108). Relay K101 provides shield
grounding. Relay K106 switches in the ICP current supply. The -30 dB input attenuator
formed by resistors R103-R106 serves to attenuate very large signals as well as providing
protection to the input FET in the presence of very high voltages (> 50 Vpk). To prevent
damage to the input FET, the input voltage is monitored by comparators U106 and U107.
High voltages cause the input attenuator to be automatically engaged regardless of the
user gain setting at the front panel. Resistors R107 and R108 provide some input
protection to the input FET, with only a slight penalty in input voltage noise.

The input FET U100 is an extremely low-noise matched pair of FET's with a voltage
input noise of approximately 3.5 nV/\Hz. To improve distortion performance, the input
FET’s are cascoded to maintain a constant drain-source voltage across each FET. This
prevents modulation of the drain-source voltage by the input voltage. U104 senses the
source voltage and maintains the same voltage at the drain with some DC offset
determined by resistors N102 and N103. U103B provides common-mode feedback and
maintains a constant drain current in each FET. U105 provides the single-ended output.
The gain of the front end is either 10 dB or 20 dB as selected by relay K107. When a gain
of 10 dB is selected, the offset and CMR are adjusted via P104 and P103 respectively.
When a gain of 20 dB is selected, offset and CMR are adjusted via P102 and P101
respectively.

Gain Stages And Attenuators
Collectively, the front end amplifier, gain stages and attenuators provide sensitivity
ranges from -50 dBV to +34 dBV. This is accomplished through the front-end amplifier,
two gain stages and a resistive ladder attenuator.
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The two gain stages are identical inverting amplifiers. Each has selectable gain of -10 dB,
0 dB, 10 dB or 20 dB. To achieve the desired gain, the front end attenuator and amplifier
and these two gain stages are cascaded together. The signal path always includes the
same number of amplifiers.

The resistive ladder attenuator (R211-R216) provides attenuation from 0dB to -10 dB in
2 dB steps. This improves the gain resolution. U206 is the buffered amplifier output.

Comparators U220 and U392 detect overload and half-scale amplifier output based upon
the A/D converter reference voltage.

Anti-Aliasing Filter
To prevent aliasing, the input signal passes through a low-pass filter so that all frequency
components greater than half the sampling frequency are attenuated by at least 96 dB.
This is accomplished with an 8-zero 9-pole elliptical low pass filter (U230-U233). The
pass band of this filter is DC to 102.4 kHz with a ripple of 0.5 dB. The stopband begins at
156 kHz. Stopband attenuation is nominally 100 dB.

U234A follows the anti-aliasing filter to sum the DC offset correction from DAC U361
with the signal.

A second 51.2 kHz anti-aliasing filter (U240-U243) is used for two channel octave
measurements. Relays K202, K203 and K204 select an anti-aliasing filter (or bypasses
the filters altogether). The filter output is buffered by U244 A and U244B (to the trigger
circuit on the DSP board).

A-Weighting Filter
The A-Weighting filter is constructed with a standard implementation using U310A and
U310B. Relay K301 selects the filter.

U317 is a dual amplifier which splits the signal into two paths - inverted and non-
inverted. Each signal path drives one of the A/D channels.

Comparator U391 detects overload based upon the A/D converter reference voltage.

A/D Converter
The A/D Converter converts the inverted and non-inverted signals to two digital data
streams. Conversion takes place at a rate of 262,144 samples per second (FFT
Base=102.4 kHz). A Burr-Brown PCM1750 dual 18-bit A/D converter is used for this
purpose. U402A and U402D drive the data signals to the Analyzer backplane and to the
DSP board. Timing signals for the A/D Converter are received via U402B and U402C.

I/O Interface
The Analog Input board is configured by the DSP board via its serial 1/O Interface.
U601-U603 form a 24 bit shift register and latch. Data is shifted in serially from the DSP
board and latched to internal latches. The outputs of the latches are used to control relays,
switches, etc. During normal operation, this interface is static and no random digital noise
is present on this board.
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Power

U606 is a serial EEPROM containing the calibrations for the amplifier and anti-aliasing
filter. U606 is read by the host CPU (80C186) via a port on the DSP board. This
EEPROM is only read at power on and does not contribute digital noise to this board.

Several voltages are generated on the Analog Input board locally. £15 V is generated for
most of the analog IC's (U531-U532). A dedicated =15 V supply is also generated for the
front-end amplifier (U501-U502). +£5 V is generated for the A/D Converter (U521-U522)
as well as a digital +5 V for the digital I/O (U690). Analog =6 V is generated for the
analog switches (U541-U542). +12V is provided for the relays (U551). U511 provides
the high voltage bias for the ICP supply.

The +20 VDC supply which is the source of most of the power supplies is not grounded
at the power supply. It is grounded by the Analog Input board to reduce ground loops at
the analog inputs. Thus, the £20 VDC floats when no Analog Input boards are present. If
either Analog Input board is present, then this supply is grounded.
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Chapter 3

Service

This chapter provides a troubleshooting guide with service procedures to debug and repair this unit at a

board or assembly level.

In This Chapter

Before Proceeding With Service
Warranty Service
CAUTION!
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Service Procedure D2 (Battery Check)
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Before Proceeding With Service

Warranty Service

CAUTION!

Al

Reset

A

Calibration

For warranty service or repair, this product must be returned to a Stanford Research
Systems authorized service facility.

Do not attempt any service without first contacting Stanford Research Systems or an
authorized representative. Replacement parts, boards and assemblies are available only
from Stanford Research Systems or its authorized representatives.

Potentially lethal voltages are present in this instrument. This unit is to be
serviced by qualified service personnel only. There are no user
serviceable parts inside.

Check the red LED at the top edge of Power Supply board. The unit is
safe only if the LED is OFF. If the LED is ON, then voltages are present
within the unit - USE CAUTION.

Use caution when checking circuits with the power on.

Always disconnect the power cord before replacing or servicing any
component inside the chassis.

Reset the unit by turning the power off and back on while holding down the backspace
key. This clears the stored setup and re-initializes the instrument. If the problem is
solved, do not proceed to service any internal components. If the problem continues,
proceed with the proper service procedures.

Always reset the instrument after performing any service.

The only field service which may be performed is at the board and assembly level. If the
DSP board or either Analog Input board is replaced (with factory calibrated replacement
boards), the unit will remain calibrated. If individual components are replaced on a board,
the calibration is not guaranteed. Individual component replacement on the DSP or
Analog boards is not recommended.
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Troubleshooting Table

Symptoms

Procedure

Screen is blank when
power is turned on.

Does the unit beep when front panel keys are pressed?
Yes - see Display Problems.

After reset, is there a signal at the Source Output? Yes -
see Display Problems.

Proceed to Service Procedure A2 (Power Supply Check).
If the Power Supply is OK, see Display Problems.

Display Problems

Is the screen brightness turned down? Press the Brighter
button at the lower right of the screen (below the
softkeys).

Is the display unstable? Yes - proceed to Service
Procedure B2 (CRT Check).

Is the display blank? Yes - proceed to Service Procedure
B2 (CRT Check).

If there still a problem, proceed to Service Procedure D3
(Video/1O Board Replacement).

Keypad not functioning

Is there a key stuck in the down position? Yes - release
the stuck key.

Proceed to Service Procedure C1 (Keypad Check).

Knob not functioning

Proceed to Service Procedure C2 (Knob Check).

[System]|<Diagnostics>
System RAM check fails

Proceed to Service Procedure D1 (CPU Board
Replacement).

[System]<Diagnostics>
System ROM check or
Help ROM check fails

Contact SRS for replacement ROM components. If
failure continues proceed to Service Procedure D1 (CPU
Board Replacement).

[System]<Diagnostics>
Video RAM check fails

Proceed to Service Procedure D3 (Video/IO Board
Replacement).

Unit does not recall
settings at power on.

Proceed to Service Procedure D2 (Battery Check).

Clock does not keep
time correctly

Proceed to Service Procedure D2 (Battery Check).
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Symptoms Procedure
Power On DSP memory If Data Memory fails, proceed to Service Procedure F7
check fails. (Replacing DSP Memory Modules).

Use [System]<Show
Version> to review test
results.

If Program Memory fails, proceed to Service Procedure
F7 (Replacing DSP Memory Modules).

If DRAM Errors are detected, proceed to Service
Procedure F7 (Replacing DSP Memory Modules).

If the DSP Cal ROM is not OK, proceed to Service
Procedure F1 (DSP Board Replacement).

Proceed to Service Procedure F1 (DSP Board
Replacement).

Source output incorrect

Proceed to Service Procedure F6 (Checking the Source).

DSP memory upgrade To upgrade the DSP DRAM to 4M or 8M, proceed to
Service Procedure F7 (Replacing DSP Memory
Modules).

Power On Analog If the Chl or Ch2 Analog Cal ROM is not OK, proceed

memory check fails.

Use [System]<Show
Version> to review test
results.

to Service Procedure F2 (Analog Board Replacement).

Disk Drive problems

Check that your disk is DS/DD or DS/HD. Try a new
disk.

Check that the disk write protect tab is closed.

Perform the disk drive test in the [System]<Diagnostics>
menu.

Proceed to Service Procedure G1 (Disk Drive
Replacement).

If there is still a problem, proceed to Service Procedure
D3 (Video/IO Board Replacement).
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Symptoms Procedure

RS232 problems e Check that the RS232 cable is attached securely to the
RS232 port on the rear panel (NOT to the Printer port).
Use a tested cable.

e Check that the SR780 is set to output data to the RS232
interface (NOT the GPIB interface). The output interface
is set in the [System]<Remote> menu.

o Check the RS232 setup in the [System]<Remote> menu.
Make sure that the proper baud rate, word length and
parity is selected.

e Place a ‘loop back’ connector on the RS232 port. A loop
back connector is a male DB25 connector with pins 2
and 3 connected together. Perform the RS232 test in the
[System]|<Diagnostics> menu. If the test fails, proceed to
Service Procedure D3 (Video/IO Board Replacement).

GPIB problems e Check that the GPIB cable is securely fastened to the
rear panel GPIB port. Use a tested cable.

o Check that the SR780 is set to output data to the GPIB
interface (NOT the RS232 interface). The output
interface is set in the [System]<Remote> menu.

o Check the instrument GPIB address. The address is set
in the [System|<Remote> menu.

e Proceed to Service Procedure D3 (Video/IO Board
Replacement).

Printer problems e Check that the printer cable is attached securely to the
Printer port on the rear panel (NOT the RS232 port). Use
a tested cable.

o Check the Printer Type selected in the [Output] menu.
The SR780 can output to Epson compatible dot matrix
printers or HP LaserJet/InkJet compatible laser printers.

e Make sure that the printer is On-Line and has paper.

e Proceed to Service Procedure D1 (CPU Board
Replacement).
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Symptoms

Procedure

Unit displays an active
baseline spectrum but no
signal.

Apply a known 10 kHz 0.5 Vrms sine wave to the A
input of the non-functioning channel. Does the signal
appear in the spectrum? No - proceed to Service
Procedure F3 (Checking the Analog Inputs).

Does the unit pass the DSP memory checks? Use
[System]<Show Version> to review the power on test
results. No - see DSP memory check fails.

Does the unit pass the Analog board memory checks?
Use [System]<Show Version> to review the power on
test results. No - see Analog memory check fails.

No data graphed in the Does the unit pass the DSP memory checks? Use

displays. [System]|<Show Version> to review the power on test
results. No - see DSP memory check fails.
Proceed to Service Procedure D1 (CPU Board
Replacement).

Input problems Apply a known 10 kHz 0.5 Vrms sine wave to the A

(coupling, grounding or
input range).

input of the non-functioning channel. Does the signal
appear in the spectrum? No - proceed to Service
Procedure F3 (Checking the Analog Inputs).

Proceed to Service Procedure F2 (Analog Board
Replacement).

Measured amplitude of
signal not correct.

Proceed to Service Procedure F4 (Amplitude Check).

Unit does not trigger or
trigger is unstable when
in triggered mode.

Proceed to Service Procedure F5 (Trigger Check).

Large DC offset on
spectrum.

Proceed to Service Procedure J1 (Adjusting DC Offset
and CMR).

Common Mode
Rejection problem.

Proceed to Service Procedure J1 (Adjusting DC Offset
and CMR).
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Circuit Board Locations

The SR780’s circuitry is divided into two major sections - the system section and the
analyzer section. The system section contains the main processor (CPU), video display,
external interfaces, power supply and front panel. The analyzer section contains the
digital signal processor (DSP), source output and analog inputs.

System Components
The system section components are located in the left half of the chassis, behind and
below the CRT (video display). The card cage behind the CRT contains the power
supply, main CPU card and the video/IO card. The cards are interconnected by a
backplane board under the card cage. The disk drive is mounted to a small board beneath
the CRT. This card can be removed from the front. The keypad connects to the disk board
at the front of the chassis.

Figure 3-1 System Components

Chassis Top View

CPU

Video/IO

Power
Supply

Backplane

CRT
Enclosure

Disk Card

Keypad
Board

Disk Drive I

Front
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Analyzer Components
The analyzer section is in the right half of the chassis, directly behind the keypad. A card
cage contains the DSP board and two identical analog input boards. The analyzer boards
are interconnected by a backplane board under the card cage. This backplane extends all
the way to the front panel BNC connectors. The analyzer backplane connects to the
system backplane via two short cables at the center of the chassis just behind the CRT.

Figure 3-2 Analyzer Components

Chassis Top View

—

DSP Board

Chl Analog
Input Board

Ch2 Analog

Input Board

Analyzer

Backplane

Front

Schematic Diagram Locations
Schematic diagrams are located in Chapter 5.

Board/Assembly Schematic #’s (see Chapter 5)
CPU Board MCPU-1 through MCPU-9
Video/IO Board MVID-10 through MVID-14
Power Supply MPWR-1 through MPWR-2
System Backplane MBKPL-20 through MBKPL-23
Disk Card MBKPL-24

Keypad Board MKEY-1

DSP Board D780-1 through D780-9

Analog Input Boards ~ A780-1 through A780-7
Analyzer Backplane =~ M780-1 through M780-4
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Service Procedures

Caution

Potentially lethal voltages are present in this instrument. This unit is to be
V4 serviced by qualified service personnel only. There are no user

serviceable parts inside.

Check the red LED at the top edge of Power Supply board. The unit is
safe only if the LED is OFF. If the LED is ON, then voltages are present
within the unit - USE CAUTION.

Use caution when checking circuits with the power on.

Always disconnect the power cord before replacing or servicing any
component inside the chassis.

Required Equipment

1.

DC/AC Voltmeter (DVM)
5 1/2 digit accuracy
True RMS AC to 100 kHz

Recommended: Fluke 8840A with Option 09 (or equivalent).
Frequency Synthesizer (function generator)

1 Hz to 100 kHz

0.2 dB amplitude accuracy

Recommended: SRS DS335 (or equivalent).

. Philips screwdrivers (various sizes).

Slot head screwdrivers (various sizes).
Hex keys (various sizes).

Oscilloscope (10 MHz bandwidth or greater).

Service Procedure A1 (Power Supply Board Replacement)

E 1.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.
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See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding. Release the bar which secures the
boards in place.

Remove the two screws which secure the power supply shield to the rear panel.
These are located on the rear panel directly in back of the power supply board.

Remove the Power Supply board by using the card ejectors to release the board and
pull the board up and out.

Insert the new board making sure to align the board edges with the plastic card guides
before pressing the board into place. Make sure that the board is seated completely in
its socket.

Replace the two screws which secure the power supply shield to the rear panel.
Replace the bar which secures the boards in place.

Replace the top lid and refasten the eight lid screws.

Service Procedure A2 (Power Supply Check)

Al

Al

1.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Check the AC power source for the correct line voltage, either 100V, 120V, 220V or
240V (AC rms). Make sure that the power cord is OK.

Verify that the Line Voltage Selector card, located in the rear panel fuse holder, is set
so that the correct AC input voltage value is visible. Conversion to other AC input
voltages requires a change in the fuse holder voltage card position and fuse value.
Disconnect the power cord, open the fuse holder cover door and rotate the fuse-pull
lever to remove the fuse. Remove the small printed circuit board and select the
operating voltage by orienting the printed circuit board so that the desired voltage is
visible when pushed firmly into its slot. Rotate the fuse-pull lever back into its
normal position and insert the correct fuse into the fuse holder.

Verity that the correct fuse is installed. For 100V/120V, use a 1.5 A fuse. For
220V/240V, use a 3/4 A fuse. Use the DVM to verify that the fuse is not blown or
damaged.

Disconnect the power cord!

Use the DVM to check that the GND test point on the Power Supply board is
connected to the chassis and also to the ground pin of the power entry module. The
GND test point is at the top edge of the board directly behind the notch. If GND is
not shorted to chassis or power ground, check the GND (green) wires on the rear
panel chassis ground connection (above the power switch on the inside). One green
wire connects directly to the power entry module ground, the other to the System
backplane via the AC power connector.

Do not continue if there is a fault in the chassis or power
grounds!
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7. Connect the power cord and turn the power ON. The fans should turn and the red
LED at the top of the board should be ON. If the fans do not turn or the LED stays
off, turn the power OFF and remove the power cord. Check the AC power connector
and transformer connector integrity. You may need to remove the Power Supply
board to do this. See Procedure A1l for details on removing the Power Supply board.

8. Check the voltages on the power supply test points. This procedure measures the
supply voltages under load (all other boards are present) and with all grounding paths
present. If the DSP or Analog boards are not present, then the voltages labeled
ANLG, CH1+30V, CH2+30V and DIG must be measured relative to the AGND,
CHIRET, CH2RET and DGND test points.

Assuming that all other boards are present, connect the negative lead of the DVM to
the chassis. Use the positive lead to measure the test points along the top of the power
supply board, starting at the rear.

Digital Power

Test Point Nominal
-12V -12V £5%
-5V -5V £5%
+12V -12V +£5%
+5V +5V £5%
Ground ov
ANLG Power

Test Point Nominal
-28V <23V
+28V >+23V
20V 20V £5%
+20V +20V £5%
AGND ov

CH2

Test Point Nominal
+30V +30V £5%
RET ov

CH1
Test Point Nominal
+30V +30V £5%

RET ov

DIG Power

Test Point Nominal
28V <23V
+28V >+23V
20V 20V £5%
+20V +20V £5%
DGND ov

9. Ifthe supplies check ok, then replace the top lid and refasten the eight lid screws.
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10. If the supplies are not correct, try one or both of the following.

A. Follow procedure A1 to replace the power supply board and repeat this check.

B. Remove one or more of the other boards and recheck the power supply. This
assumes that the supply voltage is being affected by a bad board elsewhere in the
unit.

The Digital power drives the CPU, Video/10O, Disk cards and the CRT assembly.
The ANLG and CH1 power drives the Ch1 analog input board.

The ANLG and CH2 power drives the Ch2 analog input board.

The DIG power drives the DSP board.

If removing a board fixes the supply voltage, then proceed to replace the suspect

board or assembly.

If nothing seems to help, contact Stanford Research Systems or an authorized
representative.

Service Procedure B1 (Replacing the CRT)

TR

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Release the CRT connector cable from the System backplane (behind the CRT
enclosure).

The CRT enclosure is secured by four screws, two on the left and two on the right.
These screws are in slots in the enclosure. Remove these screws.

Slide the CRT enclosure back until the front clears the front panel bezel. Lift the
enclosure up and out (it’s heavy).

Lower the new CRT enclosure into the chassis and slide it forward. Make sure that
the slots in the enclosure overlap the mounting screw holes along the sides.

Insert the four screws which secure the enclosure. Do not tighten them.

Gently slide the CRT enclosure forward until the front of the CRT just touches the
plastic anti-glare screen. Slide the CRT back 1/8” so that the front of the CRT is just
behind the anti-glare screen. Tighten the four screws to secure the enclosure in place.

Connect the CRT cable to the System backplane (behind the CRT enclosure). Make
sure that the cable is locked into place.

10. Replace the top lid and refasten the eight lid screws.

Service Procedure B2 (CRT Check)

N

Turn the power OFF.
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Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Turn the power ON.

Use the DVM to check the +12V power supply to the CRT. See Figure 3-1 to locate
the Power Supply board. Measure the +12V test point on the Power Supply board
relative to the chassis. The voltage should be within 5% of nominal. If the +12V
supply is fine, proceed to Procedure B1 and replace the CRT assembly.

If the +12V supply is not within nominal, check the supply voltage without the CRT
connected. Turn the power OFF. Remove the CRT cable from the connector on the
System backplane (behind the CRT enclosure). Turn the power back ON. Measure
the +12V test point on the Power Supply board relative to the chassis. The voltage
should be within 5% of nominal. If the +12V supply is fine, proceed to Procedure B1
and replace the CRT assembly. If the +12V supply is still not within nominal, turn
the power OFF, replace the CRT cable and proceed to Procedure A1 (Power Supply
Replacement).

Service Procedure C1 (Keypad Check)

1.

o

10.

11.

Perform the Keypad check in the [System]<Diagnostics> menu. If the test passes,
then the keypad is OK. If the test fails or cannot be completed, then proceed.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Remove the two hex screws which connect the handle arms to the chassis. Remove
the handle by pulling the arms apart slightly.

Remove the eight screws which secure the front panel bezel to the chassis. These
screws are exposed when the lid is removed. There are two screws along each side
and the top and bottom.

Remove the front panel bezel by pulling it slowly off towards the front. The keypad
is attached to the bezel. There is a ground wire and cable extending from the keypad
back to the main chassis.

The keypad and knob are attached to the Disk card by a ribbon cable. This cable
attaches next to the Keyboard connector below the CRT. The cable attaches to the
back of the keypad board (on the front panel). Make sure that the cable is firmly
attached at both ends and that the cable is not damaged.

Check that the ground wire is attached firmly to the chassis and to the keypad board.

Push the Disk card inward to make sure that it is seated properly. The keypad signals
are carried to the System backplane via this card.

Replace the front panel bezel, being careful to engage the slots which secure the front
of the Disk card.

Replace the eight bezel screws. Replace the handle and the pivot screws.
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12.

13.

If the keypad still does not function, then the problem may be on the CPU board. The
keypad circuit board contains no active circuitry and the rubber keys are very
unlikely to fail. To replace the CPU board, follow Procedure D1 (CPU Board
Replacement).

Replace the top lid and refasten the eight lid screws.

Service Procedure C2 (Knob Check)

A

1.

10.

11.
12.

13.

Perform the Knob check in the [System]<Diagnostics> menu. Verify knob rotation
and direction. If the test passes, then the knob is OK. If the test fails or cannot be
completed, then proceed.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Remove the two hex screws which connect the handle arms to the chassis. Remove
the handle by pulling the arms apart slightly.

Remove the eight screws which secure the front panel bezel to the chassis. These
screws are exposed when the lid is removed. There are two screws along each side
and the top and bottom.

Remove the front panel bezel by pulling it slowly off towards the front. The knob is
attached to the bezel. There is a ground wire and cable extending from the keypad
back to the main chassis.

The knob is connected by a 5 wire ribbon cable to the keypad assembly. Check that
the cable is secure at both ends.

The keypad and knob are attached to the Disk card by a ribbon cable. This cable
attaches next to the Keyboard connector below the CRT. The cable attaches to the
back of the keypad board (on the front panel). Make sure that the cable is firmly
attached at both ends and that the cable is not damaged.

Check that the ground wire is attached firmly to the chassis and to the keypad board.

Push the Disk card inward to make sure that it is seated properly. The knob signals
are carried to the System backplane via this card.

If the knob still fails to function, proceed to replace the digital pot.

The digital pot is secured to the front panel bezel by a nut underneath the plastic knob
(on the outside). Pry off the front cover of the plastic knob with a small screwdriver
or your fingertips. (The cover is the plastic disk with the dimple in it.) Remove the
plastic knob by loosening the nut which holds the plastic knob onto the digital pot’s
shaft.

Remove the mounting nut at the base of the shaft. Once this nut is removed, the pot
can be removed from the bezel. Pull the pot free while leaving the cable attached.
Move the cable from the old pot to the new pot maintaining the correct cable
orientation.
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14.

15.

16.
17.

18.

Place the new pot shaft into the hole in the bezel and secure the shaft with the
mounting nut. Replace the plastic knob on the shaft and tighten the nut at the center.
Replace the knob cover.

Replace the front panel bezel, being careful to engage the slots which secure the front
of the Disk card.

Replace the eight bezel screws. Replace the handle and the pivot screws.

If the knob still does not function, then the problem may be on the CPU board. The
keypad circuit board contains no active circuitry and is very unlikely to fail. To
replace the CPU board, follow Procedure D1 (CPU Board Replacement).

Replace the top lid and refasten the eight lid screws.

Service Procedure D1 (CPU Board Replacement)

1.

¥

8.
9.

10.

Before replacing the CPU board, reset the unit by turning the power OFF and ON
while holding down the backspace key. If this does not fix the problem, continue.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding. Release the bar which secures the
boards in place.

See Figure 3-1 to locate the CPU board (it’s next to the Power Supply board).

Remove the CPU board by using the card ejectors to release the board and pull the
board up and out.

Insert the new board making sure to align the board edges with the plastic card guides
before pressing the board into place. Make sure that the board is seated completely in
its socket.

Replace the bar which secures the boards in place.
Replace the top lid and refasten the eight lid screws.
Reset the unit by turning the power ON while holding down the backspace key.

Service Procedure D2 (Battery Check)

E 1.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.
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See Figure 3-1 to locate the CPU board (it’s next to the Power Supply board). Use
the DVM to measure the battery voltage at the BATT test point at the top of the
board. (There are two test points, BATT is the one towards the rear.) The battery
voltage should be at least 2.7V relative to the chassis. If the battery voltage is low,
then proceed to replace the battery.

Release the bar which secures the boards in place. Remove the CPU board by using
the card ejectors to release the board and pull the board up and out. Desolder the two
battery pins. Cut the plastic tie which secures the battery and remove the battery.
Insert a new battery (check the polarity!) solder the two pins. Secure the battery with
a new tie if available.

Replace the CPU board making sure to align the board edges with the plastic card
guides before pressing the board into place. Make sure that the board is seated
completely in its socket.

Reset the unit by turning the power ON while holding down the backspace key. If the
unit continues to have battery problems, then follow Procedure D1 to replace the
CPU board.

Service Procedure D3 (Video/IO Board Replacement)

1.

¥

8.
9.

Before replacing the Video/IO board, reset the unit by turning the power OFF and
ON while holding down the backspace key. If this does not fix the problem, continue.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding. Release the bar which secures the
boards in place.

See Figure 3-1 to locate the Video/IO board (it’s farthest from the Power Supply
board).

Remove the Video/IO board by using the card ejectors to release the board and pull
the board up and out.

Insert the new board making sure to align the board edges with the plastic card guides
before pressing the board into place. Make sure that the board is seated completely in
its socket.

Replace the bar which secures the boards in place.

Replace the top lid and refasten the eight lid screws.

10. Reset the unit by turning the power ON while holding down the backspace key.

Service Procedure F1 (DSP Board Replacement)

1.

Before replacing the DSP board, reset the unit by turning the power OFF and ON
while holding down the backspace key. If this does not fix the problem, continue.
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8.
9.

E 2.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

See Figure 3-2 to locate the DSP board (in the Analyzer card cage nearest the CRT).
Remove the card cage cover by loosening the five screws in the cover.

Remove the DSP board by using the card ejectors to release the board and pull the
board up and out.

Insert the new board making sure to align the board edges with the plastic card
guides. Make sure that the board is aligned with the connectors and jacks at the
bottom of the card cage before pressing the board into place. Do not press the board
in if the jacks at the front are not engaged properly. These jacks are easily
damaged! Make sure that the board is seated completely in its socket.

Replace the card cage cover and tighten the cover screws.

Replace the top lid and refasten the eight lid screws.

10. Reset the unit by turning the power ON while holding down the backspace key.

Service Procedure F2 (Analog Board Replacement)

1.

¥

Before replacing an Analog board, reset the unit by turning the power OFF and ON
while holding down the backspace key. If this does not fix the problem, continue.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

See Figure 3-2 to locate the Analog boards (in the Analyzer card cage behind the
input BNC connectors). Remove the card cage cover by loosening the five screws in
the cover.

The Channel 1 Analog board is in the center of the card cage. The Channel 2 Analog
board is on the right. Pull off the small shield at the front using the finger hole.
Remove the correct Analog board by using the card ejectors to release the board and
pull the board up and out.

Insert the new board making sure to align the board edges with the plastic card
guides. Make sure that the board is aligned with the connectors and jacks at the
bottom of the card cage before pressing the board into place. Do not press the board
in if the jacks at the front are not engaged properly. These jacks are easily
damaged! Make sure that the board is seated completely in its socket.
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10.

Replace the small shield at the front. Replace the card cage cover and tighten the
COVer SCIews.

Replace the top lid and refasten the eight lid screws.
Reset the unit by turning the power ON while holding down the backspace key.

Service Procedure F3 (Checking the Analog Inputs)

Al

1.

Before proceeding, reset the unit by turning the power OFF and ON while holding
down the backspace key. If this does not fix the problem, continue.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

See Figure 3-2 to locate the Analog boards (in the Analyzer card cage behind the
input BNC connectors). Remove the card cage cover by loosening the five screws in
the cover.

The Channel 1 Analog board is in the center of the card cage. The Channel 2 Analog
board is on the right. Pull off the small shield at the front using the finger hole.
Remove the correct Analog board by using the card ejectors to release the board and
pull the board up and out.

Use the DVM to verify that the A input BNC center conductor and shield are
connected to the front most SMB jack at the bottom of the card cage (directly behind
the inputs). The BNC center conductor connects to the female center of the SMB
jack. The BNC shield connects to the SMB shield. Use the DVM to verify that the B
input BNC connects properly to the rear most SMB jack. If both connections are OK,
proceed to Procedure F2 to replace the Analog board. Otherwise contact SRS for
more information.

Service Procedure F4 (Checking the Amplitude)

1.

Check the amplitude accuracy by following the procedure outlined in Performance
Test 4 (Amplitude Accuracy and Flatness) in Chapter 6 of the SR780 Operating
Manual. If the test passes, then check the signal source in question. If the test fails,
follow Procedure F2 to replace an Analog board.

Service Procedure F5 (Checking the Trigger)

1.

Internal Trigger check: Reset the unit by holding down the backspace key while
turning the power ON. Use the function generator to apply a known 10 kHz, 0.5
Vrms sine wave to both A inputs. Verify that the signal appears in both spectra (do
not change any settings). In the [Trigger] menu, set the Trigger Mode to Auto Arm.
Set the Trigger Source to Chl and verify that the Trig indicator in the display turns
on. Set the Trigger Source to Ch2 and verify that the Trig indicator turns on. If
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neither trigger source works, follow Procedure F1 to replace the DSP board. If one of
the internal sources fails, the problem is probably with the Analog board for that
channel. Follow Procedure F2 to replace the Analog board. If both trigger sources are
OK, continue.

2. External Trigger check: Reset the unit by holding down the backspace key while
turning the power ON. Use the function generator to apply a known 10 kHz, 0.5
Vrms sine wave to the Chl A input. Use a BNC cable to connect the signal to the
Trigger Input as well. Verify that the signal appears in the top spectrum (do not
change any settings). In the [Trigger] menu, set the Trigger Mode to Auto Arm. Set
the Trigger Source to External and verify that the Trig indicator in the display turns
on. If the unit does not trigger, proceed to step 4.

3. External TTL Trigger check: Reset the unit by holding down the backspace key
while turning the power ON. Use the function generator to apply a known 10 kHz,
0.5 Vrms sine wave to the Chl A input. Use a BNC cable to connect the function
generator TTL SYNC output to the Trigger Input as well. Verify that the signal
appears in the top spectrum (do not change any settings). In the [Trigger] menu, set
the Trigger Mode to Auto Arm. Set the Trigger Source to Ext TTL and verify that the
Trig indicator in the display turns on. If the unit does not trigger, proceed to step 4.

4. Turn the power OFF. Remove the power cord from the power
/\« entry module.

5. Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

6. See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

7. See Figure 3-2 to locate the DSP board (in the Analyzer card cage closest to the
CRT). Remove the card cage cover by loosening the five screws in the cover.

8. Remove the DSP board by using the card ejectors to release the board and pull the
board up and out.

9. Use the DVM to verify that the Trigger Input BNC center conductor and shield are
connected to the rear most SMB jack at the bottom of the card cage (directly behind
the Trigger Input). The BNC center conductor connects to the female center of the
SMB jack. The BNC shield connects to the SMB shield. If the connection is OK,
follow Procedure F1 to replace the DSP board. Otherwise contact SRS for more
information.

Service Procedure F6 (Checking the Source)

1. Check the source output on the oscilloscope. Reset the unit by holding down the
backspace key while turning the power ON. Connect the Source Output to the
oscilloscope. In the [Source] menu, choose Sine. A 10.24 kHz, 1.0 Vpp sine wave
should be displayed on the oscilloscope. If not, continue.

2. Turn the power OFF. Remove the power cord from the power
/\« entry module.
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Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

See Figure 3-2 to locate the DSP board (in the Analyzer card cage closest to the
CRT). Remove the card cage cover by loosening the five screws in the cover.

Remove the DSP board by using the card ejectors to release the board and pull the
board up and out.

Use the DVM to verify that the Source Output BNC center conductor and shield are
connected to the front most SMB jack at the bottom of the card cage (directly behind
the Source Output). The BNC center conductor connects to the female center of the
SMB jack. The BNC shield connects to the SMB shield. If the connection is OK,
follow Procedure F1 to replace the DSP board. Otherwise, contact SRS for more
information.

Service Procedure F7 (DSP Memory Module Replacement)

Al

1.

Before replacing a memory module, reset the unit by turning the power OFF and ON
while holding down the backspace key. If this does not fix the problem, continue.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

See Figure 3-1 to locate the Power Supply board. Make sure that the red LED at the
top edge of the board is OFF before proceeding.

See Figure 3-2 to locate the DSP board (in the Analyzer card cage nearest the CRT).
Remove the card cage cover by loosening the five screws in the cover.

Remove the DSP board by using the card ejectors to release the board and pull the
board up and out.

There are three memory SIMM modules on the DSP board. They are the DRAM,
Data Memory and Program Memory. The Data and Program modules are SRS
custom parts and must be replaced with SRS supplied parts. The standard DRAM
buffer is a 2Mx32, 70ns (or faster), 72 pin SIMM.

The DRAM upgrades are 4Mx32 and 8Mx32, 70ns (or faster), 72 pin SIMM’s. The
DRAM module must have its identification pin(s) grounded in order to work in the
SR780. These pins are standard in all modules but may not be connected in modules
not supplied by SRS. Check the data sheet for the module to ensure that the correct
ID pins are connected.

To remove a memory module, simply release the spring latches at each end of the
socket.

Insert the new module, making sure that the notch end is correctly positioned. Make
sure that the spring latches are engaged around the edge of the board.
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10.

11.
12.
13.

Replace the DSP board making sure to align the board edges with the plastic card
guides. Make sure that the board is aligned with the connectors and jacks at the
bottom of the card cage before pressing the board into place. Do not press the board
in if the jacks at the front are not engaged properly. These jacks are easily
damaged! Make sure that the board is seated completely in its socket.

Replace the card cage cover and tighten the cover screws.
Replace the top lid and refasten the eight lid screws.
Reset the unit by turning the power ON while holding down the backspace key.

Service Procedure G1 (Replacing the Disk Drive)

E 1.

10.

11.
12.
13.

Turn the power OFF. Remove the power cord from the power
entry module.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards.

Remove the two hex screws which connect the handle arms to the chassis. Remove
the handle by pulling the arms apart slightly.

Remove the eight screws which secure the front panel bezel to the chassis. These
screws are exposed when the lid is removed. There are two screws along each side
and the top and bottom.

Remove the front panel bezel by pulling it slowly off towards the front. The keypad
is attached to the bezel. There is a ground wire and cable extending from the keypad
back to the main chassis.

The keypad and knob are attached to the Disk card by a ribbon cable. This cable
attaches next to the Keyboard connector below the CRT. Note the cable orientation
and remove the cable from the Disk card.

Pull the Disk card straight out to remove it.

Insert the new Disk card. Make sure that the card is in the plastic card guides under
the CRT. Do not force the card in if the card is not in the guides. Push the card in
until the connector is secure.

Reattach the keypad cable to the Disk card.

Replace the front panel bezel, being careful to engage the slots which secure the front
of the Disk card.

Replace the eight bezel screws. Replace the handle and the pivot screws.
Replace the top lid and refasten the eight lid screws.

Replace the power cord. Reset the unit by turning the power ON while holding down
the backspace key. Run the Disk test in the [System]<Diagnostics> menu.
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Service Procedure J1 (Adjusting the DC Offset and CMR)

1.

The DC Offset and CMR adjustments affect each other and must be done together.
This procedure requires a 50€2 terminator. A small (but long) slotted screwdriver is
required to adjust the potentiometers.

Reset the unit by turning the power ON while holding down the backspace key. Let it
warm up for at least an hour.

The adjustment procedure for the two channels is the same. The procedure described
below uses Channel 1 as the example. To adjust Channel 2, press [Active Display] to
switch to DisplayB (Spectrum of Ch2) and when necessary, adjust the Ch2 input
parameters in the [Input] menu and make the input connections to the Ch2 A and B
inputs. Press [Auto Scale B] instead of [Auto Scale A] when necessary.

Remove the eight black screws which secure the top lid. There are four screws on
each side, two at the front and two at the rear. Remove the lid by pulling the lid
towards the back and upwards. Remove the card cage cover by loosening the five
screws which secure it.

The adjustment pots on the Analog board are towards the front. Remove the small
shield cover at the front of the Analog board. Simply pull the shield up using the
finger hole.

The five adjustment pots are shown in Figure 3-3. Do not make any other
adjustments!

5 Outnut Offset

|Analog Board
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Figure 3-3 Analog Adjustments

Press the following keys to clear the internal offset calibrations and turn Auto Offset
Off.

[System]
<Diagnostics>
<Kill AutoOft>
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7. Press the following keys to set the input configuration and frequency span.

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[0] [Enter]
<Chl Grounding> (<Ch2 Grounding>)
Select (Ground) [Enter]
<Chl Coupling> (<Ch1 Coupling>)
Select (DC) [Enter]

[Freq]
<Span>
[1][.][6] Select (kHz) [Enter]
<Start Freq.>
[0] [Enter]

[Marker]
<Width>
[Link] Select (Spot) [Enter]

8. Connect a 50€2 termination to the Chl (Ch2) A input. This shorts the input to ground
so the analyzer’s own DC offset is measured.

Rotate the knob so that the marker is at 0 Hz. The marker positions display above the
graph should read 0 Hz. The marker amplitude is the DC offset.

If the marker reading is less than -50 dBV (remember, -40 dBV is greater than -
50 dBV and -60 dBV is less than -50 dBV) then proceed to the next step. If the
reading is greater than -50 dBV, adjust the Output Offset pot to minimize the
marker reading (see Fig 3-3).

9. Press

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[-1[2][0] [Enter]
[Auto Scale A] [Auto Scale B
If the marker reading is less than -70 dBV (remember, -60 dBV is greater than
-70 dBV and -80 dBYV is less than -70 dBV) then proceed to the next step. If the

reading is greater than -70 dBV, adjust the High Gain Offset pot to minimize the
marker reading (see Fig 3-3).

10. Press

[Input]
<Ch1 Input Range> (<Ch2 Input Range>)
[-1[5] [0] [Enter]

[Auto Scale A] [Auto Scale B

If the marker reading is less than -85 dBV (remember, -80 dBV is greater than

-85 dBV and -90 dBV is less than -85 dBV) then proceed to the next step. If the
reading is greater than -85 dBV, adjust the High Gain Offset pot to minimize the
marker reading (see Fig 3-3).

11. Press
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12.

13.

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[0] [Enter]

[Auto Scale A] [Auto Scale B]

If the marker reading is less than -50 dBV (remember, -40 dBV is greater than

-50 dBV and -60 dBV is less than -50 dBV) then proceed to the next step. If the
reading is greater than -50 dBV, adjust the Low Gain Offset pot to minimize the
marker reading (see Fig 3-3).

Connect the Source Output to both the Chl A and B inputs (Ch2 A and B). Use equal
length cables from A and B to a BNC TEE. Connect the cable from the Source
Output to the TEE.

Press

[Source]
<Sine>
<Frequency 1>
[1]1.]10] [2] [4] Select (kHz) [Enter]

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[-]1[2] [Enter]
[Auto Scale A] [Auto Scale B]

Use the knob to move the marker to 1.024 kHz. The amplitude should be
-6 dBV.

[Marker Ref] {Marker now reads relative to the signal amplitude}

[Input]
<Chl Input Mode> <Ch2 Input Mode>
Select (A-B) [Enter]

Do not move the marker. The marker reading is the common mode rejection ration
(CMRR). If the reading is below -100 dB, then do not make any adjustment. If the
reading is above -100 dB, then adjust the High Gain CMR pot to minimize the
reading (see Fig 3-3).

Press

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[0] [Enter]
<Ch1 Input Mode> <Ch2 Input Mode>
Select (A) [Enter]

[Auto Scale A] [Auto Scale B]
[Marker Ref] {Marker now reads absolute signal amplitude}

Use the knob to move the marker to 1.024 kHz. The amplitude should be
-6 dBV.

[Marker Ref] {Marker now reads relative to the signal amplitude}
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[Input]
<Chl Input Mode> <Ch2 Input Mode>
Select (A-B) [Enter]

Do not move the marker. The marker reading is the common mode rejection ration
(CMRR). If the reading is below -80 dB, then do not make any adjustment. If the
reading is above -80 dB, then adjust the Low Gain CMR pot to minimize the
reading (see Fig 3-3).

14. Remove the cables from the A and B inputs. Connect a 50Q2 termination to the Ch1
(Ch2) A input. This shorts the input to ground so the analyzer’s own DC offset is
measured.

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[-1 [5][0] [Enter]
<Chl1 Input Mode> <Ch2 Input Mode>
Select (A) [Enter]

[Marker Ref] {Marker now reads absolute signal amplitude}

Use the knob to move the marker to 0 Hz. The marker position should
display 0 Hz. The marker reading is the DC offset.

[Auto Scale A] [Auto Scale B

If the marker reading is less than -85 dBV (remember, -80 dBV is greater than

-85 dBV and -90 dBYV is less than -85 dBV) then proceed to the next step. If the
reading is greater than -85 dBV, adjust the High Gain Offset pot to minimize the
marker reading (see Fig 3-3).

15. Press

[Input]
<Chl Input Range> (<Ch2 Input Range>)
[0] [Enter]

[Auto Scale A] [Auto Scale B

If the marker reading is less than -50 dBV (remember, -40 dBV is greater than

-50 dBV and -60 dBV is less than -50 dBV) then proceed to the next step. If the
reading is greater than -50 dBV, adjust the Low Gain Offset pot to minimize the
marker reading (see Fig 3-3).

16. This completes the adjustment procedure.

17 Replace the small shield at the front. Replace the card cage cover and tighten the
COVer SCIews.

18. Replace the top lid and refasten the eight lid screws.

19. Reset the unit by turning the power ON while holding down the backspace key. If the
DC offset or Common Mode Rejection are still a problem, repeat this procedure one
more time. Otherwise, follow Procedure F2 to replace the Analog board.
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Chapter 4
Parts Lists

This chapter lists the components on the major circuit assemblies in the SR780. The schematics for each

board are shown in Chapter 5.
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CPU Board Parts List

This section covers schematics MCPU-1 through MCPU-9 in Chapter 5.

CPU Board Parts List

Ref No. SRS Part No. Value Component Description

BT701 6-00001-612 BR-2/3A 2PIN PC Battery

Cc 101 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 102 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 401 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 602 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

C 603 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

c 701 5-00064-513 .0047U Capacitor, Mylar/Poly, 50V, 5%, Rad

C 704 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

C 705 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

C 706 5-00022-501 .001U Capacitor, Ceramic Disc, 50V, 10%, SL

C 901 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 902 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 903 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 904 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 905 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 906 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 907 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 908 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 909 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 910 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 91 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C912 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 913 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 914 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 915 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 916 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 917 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 918 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 919 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 920 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 921 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 922 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 923 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 924 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 925 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 926 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 927 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 928 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 929 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 930 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 931 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 932 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 933 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 934 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 935 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 936 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
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CPU Board Parts List
Ref No. SRS Part No. Value Component Description
C 937 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 938 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 939 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 950 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 951 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 952 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 953 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 954 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 955 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 956 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 957 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 958 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 959 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 970 5-00038-509 10U Capacitor, Electrolytic, 50V, 20%, Rad
C 971 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
Cc 972 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
D 601 3-00004-301 1N4148 Diode
D 602 3-00004-301 1N4148 Diode
D 603 3-00004-301 1N4148 Diode
D 604 3-00004-301 1N4148 Diode
D 605 3-00004-301 1N4148 Diode
D 606 3-00004-301 1N4148 Diode
D 607 3-00004-301 1N4148 Diode
D 608 3-00004-301 1N4148 Diode
D 702 3-00004-301 1N4148 Diode
D 703 3-00004-301 1N4148 Diode
D 704 3-00004-301 1N4148 Diode
D 705 3-00004-301 1N4148 Diode
J 901 1-00236-109 120 PIN RT ANGL DIN Connector, Male
N 101 4-00707-425 2.2KX7 Resistor Network SIP 1/4W 2% (Common)
N 201 4-00852-420 82X8 Resistor Network, DIP, 1/4W,2%,8 Ind
N 202 4-00852-420 82X8 Resistor Network, DIP, 1/4W,2%,8 Ind
N 203 4-00852-420 82X8 Resistor Network, DIP, 1/4W,2%,8 Ind
N 204 4-00707-425 2.2KX7 Resistor Network SIP 1/4W 2% (Common)
N 205 4-00422-421 82X5 Res. Network, SIP, 1/4W,2% (Isolated)
N 501 4-00261-425 2.2KX9 Resistor Network SIP 1/4W 2% (Common)
N 601 4-00261-425 2.2KX9 Resistor Network SIP 1/4W 2% (Common)
N 602 4-00220-420 10KX8 Resistor Network, DIP, 1/4W,2%,8 Ind
N 603 4-00244-421 10KX4 Res. Network, SIP, 1/4W,2% (Isolated)
N 701 4-00856-421 1.0KX5 Res. Network, SIP, 1/4W,2% (Isolated)
PC1 7-00522-701 MEGAPLAT CPU Printed Circuit Board
Q701 3-00022-325 2N3906 Transistor, TO-92 Package
Q705 3-00022-325 2N3906 Transistor, TO-92 Package
R 201 4-00065-401 3.3K Resistor, Carbon Film, 1/4W, 5%
R 202 4-00065-401 3.3K Resistor, Carbon Film, 1/4W, 5%
R 502 4-00065-401 3.3K Resistor, Carbon Film, 1/4W, 5%
R 707 4-00065-401 3.3K Resistor, Carbon Film, 1/4W, 5%
R 710 4-00080-401 47 Resistor, Carbon Film, 1/4W, 5%
R 711 4-00080-401 47 Resistor, Carbon Film, 1/4W, 5%
R 712 4-00021-401 1.0K Resistor, Carbon Film, 1/4W, 5%
R 713 4-00080-401 47 Resistor, Carbon Film, 1/4W, 5%
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CPU Board Parts List

Ref No. SRS Part No. Value Component Description

R 714 4-00021-401 1.0K Resistor, Carbon Film, 1/4W, 5%
R 716 4-00054-401 200K Resistor, Carbon Film, 1/4W, 5%
SO101 1-00108-150 PLCC 68 TH Socket, THRU-HOLE

S0O301 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0302 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0303 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0304 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0305 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0O306 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0801 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

S0802 1-00156-150 32 PIN 600 MIL Socket, THRU-HOLE

TP701 1-00143-101 TEST JACK Vertical Test Jack

TP702 1-00143-101 TEST JACK Vertical Test Jack

U 101 3-00595-360 80C186-20 Integrated Circuit (Surface Mount Pkg)
U 102 3-00591-340 74ACTO4 Integrated Circuit (Thru-hole Pkg)
U 103 6-00147-621 40.000 MHZ Crystal Oscillator

U 201 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 202 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 203 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 204 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 205 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 206 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 207 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 208 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 209 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 210 3-00586-340 74ACT245 Integrated Circuit (Thru-hole Pkg)
U 211 3-00587-340 74ACT32 Integrated Circuit (Thru-hole Pkg)
U212 3-00588-340 74ACTO08 Integrated Circuit (Thru-hole Pkg)
U213 3-00693-343 SR780 U213 GAL/PAL, I.C.

U214 3-00692-343 SR780 U214 GAL/PAL, I.C.

U 216 3-00587-340 74ACT32 Integrated Circuit (Thru-hole Pkg)
U 401 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 402 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 403 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 404 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 501 3-00342-340 74ALS138 Integrated Circuit (Thru-hole Pkg)
U 503 3-00342-340 74ALS138 Integrated Circuit (Thru-hole Pkg)
U 504 3-00274-340 7T4AC74 Integrated Circuit (Thru-hole Pkg)
U 505 3-00347-340 74LS148 Integrated Circuit (Thru-hole Pkg)
U 506 3-00440-340 74HC573 Integrated Circuit (Thru-hole Pkg)
U 507 3-00043-340 74HC21 Integrated Circuit (Thru-hole Pkg)
U 508 3-00303-340 74HC164 Integrated Circuit (Thru-hole Pkg)
U 601 3-00467-340 74HCT74 Integrated Circuit (Thru-hole Pkg)
U 603 3-00265-340 74HC595 Integrated Circuit (Thru-hole Pkg)
U 606 3-00440-340 74HC573 Integrated Circuit (Thru-hole Pkg)
U 607 3-00454-340 74HC574 Integrated Circuit (Thru-hole Pkg)
U 608 3-00440-340 74HC573 Integrated Circuit (Thru-hole Pkg)
U 609 3-00411-340 74HC273 Integrated Circuit (Thru-hole Pkg)
U610 3-00467-340 74HCT74 Integrated Circuit (Thru-hole Pkg)
U 611 3-00467-340 74HCT74 Integrated Circuit (Thru-hole Pkg)
U612 3-00039-340 74HC14 Integrated Circuit (Thru-hole Pkg)
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CPU Board Parts List
Ref No. SRS Part No. Value Component Description
U701 3-00594-340 MAX693A Integrated Circuit (Thru-hole Pkg)
U 702 3-00900-340 DS12C887 Integrated Circuit (Thru-hole Pkg)
U 703 3-00046-340 74HC374 Integrated Circuit (Thru-hole Pkg)
U 704 3-00263-340 DS75451N Integrated Circuit (Thru-hole Pkg)
U 705 3-00039-340 74HC14 Integrated Circuit (Thru-hole Pkg)
Z0 0-00089-033 4" Tie
Z0 0-00373-000 CARD EJECTOR Hardware, Misc.
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Video/lO Board Parts List

This section covers schematics MVID-10 through MVID-14 in Chapter 5.

Video/lO Board Parts List

Ref No. SRS Part No. Value Component Description

C 1101 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1102 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1103 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1104 5-00218-529 120P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1105 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1106 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1107 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1108 5-00218-529 120P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C 1109 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad

C 1110 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad

C 1201 5-00003-501 10P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1202 5-00003-501 10P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1203 5-00022-501 .001U Capacitor, Ceramic Disc, 50V, 10%, SL

C 1204 5-00316-512 .027U Cap, Stacked Metal Film 50V 5% -40/+85c
C 1205 5-00054-512 .047U Cap, Stacked Metal Film 50V 5% -40/+85c
C 1206 5-00022-501 .001U Capacitor, Ceramic Disc, 50V, 10%, SL

C 1303 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1304 5-00012-501 330P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1305 5-00178-501 62P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1306 5-00178-501 62P Capacitor, Ceramic Disc, 50V, 10%, SL

C 1401 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1402 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1403 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1404 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1405 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1406 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1407 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1408 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1409 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1410 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1411 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1412 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1413 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1414 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1415 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1416 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1417 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1418 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1419 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1420 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1440 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad

C 1441 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1442 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1445 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad

C 1446 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
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Video/lO Board Parts List

Ref No. SRS Part No. Value Component Description
C 1447 5-00262-548 .01U AXIAL Capacitor, Ceramic, 50V,+80/-20% Z5U AX
C 1450 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 1451 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 1452 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 1453 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
C 1454 5-00100-517 2.2U Capacitor, Tantalum, 35V, 20%, Rad
J 1401 1-00236-109 120 PIN RT ANGL DIN Connector, Male
N 1001 4-00334-425 10KX5 Resistor Network SIP 1/4W 2% (Common)
N 1101 4-00284-421 1.0KX4 Res. Network, SIP, 1/4W,2% (Isolated)
N 1102 4-00863-421 1.2KX4 Res. Network, SIP, 1/4W,2% (Isolated)
N 1201 4-00221-425 150X5 Resistor Network SIP 1/4W 2% (Common)
PC1 7-00523-701 MEGA VIDEO Printed Circuit Board
Q 1001 3-00021-325 2N3904 Transistor, TO-92 Package
Q 1002 3-00022-325 2N3906 Transistor, TO-92 Package
Q 1101 3-00022-325 2N3906 Transistor, TO-92 Package
Q1102 3-00022-325 2N3906 Transistor, TO-92 Package
Q1103 3-00022-325 2N3906 Transistor, TO-92 Package
Q1104 3-00022-325 2N3906 Transistor, TO-92 Package
Q 1105 3-00022-325 2N3906 Transistor, TO-92 Package
Q 1106 3-00022-325 2N3906 Transistor, TO-92 Package
R 1001 4-00088-401 51K Resistor, Carbon Film, 1/4W, 5%
R 1002 4-00034-401 10K Resistor, Carbon Film, 1/4W, 5%
R 1003 4-00021-401 1.0K Resistor, Carbon Film, 1/4W, 5%
R 1004 4-00785-402 100 Resistor, Carbon Comp, 1/2W, 5%
R 1101 4-00472-407 806 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1102 4-00080-401 47 Resistor, Carbon Film, 1/4W, 5%
R 1103 4-00165-407 200 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1104 4-00165-407 200 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1105 4-00472-407 806 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1106 4-00141-407 100 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1107 4-00215-407 909 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1108 4-00027-401 1.5K Resistor, Carbon Film, 1/4W, 5%
R 1109 4-00472-407 806 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1110 4-00080-401 47 Resistor, Carbon Film, 1/4W, 5%
R 1111 4-00165-407 200 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1112 4-00472-407 806 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1113 4-00165-407 200 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1114 4-00141-407 100 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1115 4-00215-407 909 Resistor, Metal Film, 1/8W, 1%, 50PPM
R 1116 4-00027-401 1.5K Resistor, Carbon Film, 1/4W, 5%
R 1117 4-00041-401 150 Resistor, Carbon Film, 1/4W, 5%
R 1201 4-00273-401 5.6K Resistor, Carbon Film, 1/4W, 5%
R 1202 4-00034-401 10K Resistor, Carbon Film, 1/4W, 5%
R 1204 4-00090-401 560 Resistor, Carbon Film, 1/4W, 5%
R 1205 4-00090-401 560 Resistor, Carbon Film, 1/4W, 5%
R 1301 4-00022-401 1.0M Resistor, Carbon Film, 1/4W, 5%
R 1302 4-00062-401 270 Resistor, Carbon Film, 1/4W, 5%
R 1303 4-00034-401 10K Resistor, Carbon Film, 1/4W, 5%
R 1304 4-00084-401 5.1K Resistor, Carbon Film, 1/4W, 5%
S0O1201 1-00232-150 52 PLCC TH Socket, THRU-HOLE
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Ref No. SRS Part No. Value Component Description

TP2 1-00143-101 TEST JACK Vertical Test Jack

TP101 1-00143-101 TEST JACK Vertical Test Jack

TP102 1-00143-101 TEST JACK Vertical Test Jack

TP103 1-00143-101 TEST JACK Vertical Test Jack

TP104 1-00143-101 TEST JACK Vertical Test Jack

TP105 1-00143-101 TEST JACK Vertical Test Jack

TP106 1-00143-101 TEST JACK Vertical Test Jack

U 1001 6-00178-621 19.590 MHZ Crystal Oscillator

U 1002 3-00274-340 74AC74 Integrated Circuit (Thru-hole Pkg)
U 1003 3-00598-340 63484P-98 Integrated Circuit (Thru-hole Pkg)
U 1004 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 1005 3-00585-340 74ACT573 Integrated Circuit (Thru-hole Pkg)
U 1006 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 1007 3-00551-341 128KX8-70 STATIC RAM, I.C.

U 1008 3-00592-340 74ACT299 Integrated Circuit (Thru-hole Pkg)
U 1009 3-00592-340 74ACT299 Integrated Circuit (Thru-hole Pkg)
U 1010 3-00592-340 74ACT299 Integrated Circuit (Thru-hole Pkg)
U 1011 3-00592-340 74ACT299 Integrated Circuit (Thru-hole Pkg)
U 1012 3-00277-340 74HC11 Integrated Circuit (Thru-hole Pkg)
U 1013 3-00274-340 74AC74 Integrated Circuit (Thru-hole Pkg)
U 1014 3-00274-340 74AC74 Integrated Circuit (Thru-hole Pkg)
U 1016 3-00591-340 74ACTO4 Integrated Circuit (Thru-hole Pkg)
u 1017 3-00588-340 74ACTO08 Integrated Circuit (Thru-hole Pkg)
U 1101 3-00241-340 AD7528JN Integrated Circuit (Thru-hole Pkg)
U 1102 3-00087-340 LF347 Integrated Circuit (Thru-hole Pkg)
U 1103 3-00122-325 79L05 Transistor, TO-92 Package

U 1201 3-00596-360 DP8473AV Integrated Circuit (Surface Mount Pkg)
U 1202 3-00645-340 NAT9914BPD Integrated Circuit (Thru-hole Pkg)
U 1203 3-00078-340 DS75160A Integrated Circuit (Thru-hole Pkg)
U 1204 3-00079-340 DS75161A Integrated Circuit (Thru-hole Pkg)
U 1301 3-00051-340 74HCUO4 Integrated Circuit (Thru-hole Pkg)
U 1303 8-00091-860 SR215 SRS sub assemblies

U 1304 3-00110-340 MC1489 Integrated Circuit (Thru-hole Pkg)
U 1305 3-00109-340 MC1488 Integrated Circuit (Thru-hole Pkg)
U 1401 3-00342-340 74ALS138 Integrated Circuit (Thru-hole Pkg)
U 1402 3-00342-340 74ALS138 Integrated Circuit (Thru-hole Pkg)
X 1201 6-00068-620 24.000 MHZ Crystal

X 1301 6-00037-620 3.6864 MHZ Crystal

Z0 0-00373-000 CARD EJECTOR Hardware, Misc.
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4-10 Parts List

Power Supply Board Parts List

This section covers schematics MPRW-1 through MPRW-2 in Chapter 5.

Power Supply Board Parts List

Ref No. SRS Part No. Value Component Description

C1 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
Cc2 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C3 5-00022-501 .001U Capacitor, Ceramic Disc, 50V, 10%, SL
C4 5-00134-529 100P Cap, Monolythic Ceramic, 50V, 20%, Z5U
C5 5-00219-529 .01U Cap, Monolythic Ceramic, 50V, 20%, Z5U
C6 5-00022-501 .001U Capacitor, Ceramic Disc, 50V, 10%, SL
Cc10 5-00124-526 5600U Capacitor, Electrolytic, 35V, 20%, Rad
C1 5-00124-526 5600U Capacitor, Electrolytic, 35V, 20%, Rad
C12 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C13 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C14 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C15 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 20 5-00124-526 5600U Capacitor, Electrolytic, 35V, 20%, Rad
c21 5-00124-526 5600U Capacitor, Electrolytic, 35V, 20%, Rad
C 22 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
Cc23 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C24 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C25 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 30 5-00041-509 220U Capacitor, Electrolytic, 50V, 20%, Rad
C 31 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 32 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 40 5-00041-509 220U Capacitor, Electrolytic, 50V, 20%, Rad
C 41 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C42 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 50 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 51 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad

C 52 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
C53 5-00127-524 2.2U Capacitor, Tantalum, 50V, 20%, Rad
D1 3-00479-301 MUR410 Diode

D2 3-00479-301 MUR410 Diode

D3 3-00479-301 MUR410 Diode

D4 3-00479-301 MUR410 Diode

D5 3-00479-301 MUR410 Diode

D6 3-00479-301 MUR410 Diode

D7 3-00479-301 MUR410 Diode

D8 3-00479-301 MUR410 Diode

D9 3-00004-301 1N4148 Diode

D10 3-00004-301 1N4148 Diode

D 11 3-00004-301 1N4148 Diode

D12 3-00004-301 1N4148 Diode

D13 3-00011-303 RED LED, T1 Package

D